Contents

Send Us Your Comments ................................................................................................................... ix

Preface ........................................................................................................................................................ i

  Intended Audience ................................................................................................................................. i
  Structure of the User’s Guide .................................................................................................................... i
  Related Documents ................................................................................................................................ ii
    Keyboard Equivalents............................................................................................................................ ii

1 Introduction to the Oracle Internet File System

  Oracle Internet File System at a Glance .................................................................................................. 1-2
    Windows Interface ................................................................................................................................. 1-2
    Web Interface ....................................................................................................................................... 1-3
    The Web Folders Hierarchy .................................................................................................................. 1-4
    E-mail ................................................................................................................................................ 1-5
    FTP ..................................................................................................................................................... 1-7
  Comparing Standard File Systems to Oracle iFS .................................................................................. 1-8
  How Does Oracle iFS Help Me Do My Work Faster? .......................................................................... 1-9

2 Getting Started with Oracle Internet File System

  Overview: Accessing Oracle iFS ............................................................................................................. 2-2
    Setting Up an Oracle iFS Account ......................................................................................................... 2-2
**Windows: Accessing Oracle iFS**

- Step 1: Map a Network Drive to Oracle iFS ................................................................. 2-3
- Step 2: Install the Oracle iFS Utilities ........................................................................ 2-5

**Web: Accessing Oracle iFS** ......................................................................................... 2-8

- Logging into Oracle iFS ............................................................................................ 2-8
- Parts of the Web Interface ......................................................................................... 2-9
- Navigating the Folder Hierarchy .............................................................................. 2-17

**Web Folders** ........................................................................................................ 2-18

- Installing Web Folders ........................................................................................... 2-18
- Adding Web Folders ............................................................................................... 2-20
- Working with Web Folders on Your Oracle iFS Drive ............................................ 2-21

**FTP: Accessing Oracle iFS** ...................................................................................... 2-21

- Configuring Your FTP Client .................................................................................... 2-21

**E-mail: Accessing Oracle iFS** .................................................................................. 2-22

- Configuring Your E-mail Application to Use the Oracle iFS Server ...................... 2-25
- Using the Oracle iFS Server for E-mail Access ......................................................... 2-26

### 3 Managing Files and Folders

**Windows: Working with Folders** ............................................................................ 3-5

- The Default Folders ................................................................................................. 3-2
- Rules for Accessing Folders ..................................................................................... 3-4
- XML and Oracle iFS ............................................................................................... 3-5

**Windows: Working with Files** ................................................................................ 3-7

**Web: Working with Folders** .................................................................................... 3-7

- Opening a Folder .................................................................................................... 3-7
- Closing a Folder .................................................................................................... 3-8
- Creating a New Folder ............................................................................................ 3-8
- Renaming a Folder ................................................................................................ 3-8
- Copying a Folder .................................................................................................... 3-8
- Moving a Folder .................................................................................................... 3-9
- Deleting a Folder.................................................................................................... 3-9

**Web: Working with Files** ....................................................................................... 3-9

- Opening a File .................................................................................................... 3-9
- Uploading Files .................................................................................................... 3-10
Copying Files.................................................................................................................. 3-15
Moving Files................................................................................................................... 3-16
Deleting Files................................................................................................................. 3-16
Renaming a File ................................................................................................................. 3-16

Using Links to Display the Same File in Multiple Folders.................................................. 3-17
  What are Links? .................................................................................................................. 3-17
  How Links Work ............................................................................................................... 3-17
  Multiple Parents........................................................................................................... 3-18

Windows: Creating a Link ................................................................................................. 3-18

Windows: Viewing a File's Parent Folders ........................................................................ 3-19

Web: Creating a File Link .................................................................................................. 3-22

Web: Displaying a Document's Parents .......................................................................... 3-22

Web: Deleting a File Link ................................................................................................. 3-22

Introduction to File Attributes ........................................................................................ 3-23
  Working with Custom Attributes ..................................................................................... 3-23

Windows: Working with Attributes .................................................................................. 3-23
  iFS Attributes Tab: File Attributes ................................................................................ 3-25
  Changing Attribute Values ............................................................................................. 3-26
  Setting an Expiration Date ............................................................................................ 3-27

Web: Working with Properties .......................................................................................... 3-28
  Viewing and Editing File Properties .............................................................................. 3-30
  Setting an Expiration Date ............................................................................................ 3-30

4
Finding Information in the Oracle iFS Repository

Finding Information: An Overview.................................................................................. 4-2
Types of Searches in Oracle iFS ..................................................................................... 4-2
  About Attribute Searching .............................................................................................. 4-3
  About Content Searching with Oracle interMedia Text .............................................. 4-3
  About Theme Searching with Oracle interMedia Text .................................................. 4-4

Windows: Finding Oracle iFS Files .................................................................................. 4-5
  Windows: Searching by File Name and Location ......................................................... 4-8
  Windows: Searching By Date Criteria .......................................................................... 4-9
  Windows: Searching by File Type and Size ................................................................. 4-11
  Windows: Searching by Content Criteria ..................................................................... 4-13
Windows: Executing the Search ............................................................................................... 4-14

Web: Finding Files in Oracle iFS ............................................................................................. 4-15
  Web: Performing a Basic Search .......................................................................................... 4-16
  Web: Performing an Advanced Search ................................................................................ 4-18

Custom Searches in Oracle iFS .............................................................................................. 4-22
  Common Search Operators .................................................................................................. 4-23
  Advanced Search Operators .................................................................................................. 4-23
  Web: ABOUT and WITHIN Searches .................................................................................. 4-24

5 Content Management Functions

Overview of Oracle iFS Content Management ....................................................................... 5-2

Introduction to Versioning ...................................................................................................... 5-2
  How Versioning Works ......................................................................................................... 5-3
  How to Copy Versioned Files .............................................................................................. 5-4
  Nonversioned vs. Versioned Files ......................................................................................... 5-5

Windows: Making a File Versioned ....................................................................................... 5-7

Windows: Viewing a File's Version History .......................................................................... 5-8

Windows: Accessing a Previous Version of a File .................................................................. 5-9

Windows: Removing Versions ................................................................................................... 5-9

Web: Making a File Versioned .................................................................................................. 5-10

Web: Accessing a Previous Version of a File .......................................................................... 5-11

Web: Working With Multiple Versions of a File ...................................................................... 5-13

Introduction to Check In and Check Out ............................................................................... 5-13
  How Does Check In/Check Out Work? .................................................................................. 5-13
  What Happens When a File Is Checked Out? ....................................................................... 5-14
  What Happens When a File Is Checked In? .......................................................................... 5-14

Windows: Checking Out a File .................................................................................................. 5-15

Windows: Checking In a File ................................................................................................... 5-15

Web: Checking Out a File ......................................................................................................... 5-16

Web: Checking In a File ........................................................................................................... 5-16

Web: Canceling a Check Out .................................................................................................... 5-17

Introduction to Locking ........................................................................................................... 5-17

Windows: Locking and Unlocking Files .................................................................................. 5-18

Web: Locking and Unlocking Files ........................................................................................... 5-19
6 Managing Access to Files

Security in Oracle iFS ................................................................. 6-2
ACLs and ACEs ........................................................................... 6-2
  Granting Access to Files and Folders ....................................... 6-4
Introduction to Permissions ..................................................... 6-5
  ACE Precedence ..................................................................... 6-6
Types of ACL ............................................................................ 6-7
The System Administrator’s Role .............................................. 6-9
  What You Can Do .................................................................. 6-9
Windows: Changing Your Password ......................................... 6-10
Web: Changing Your Password ................................................. 6-11
Windows: Assigning a Default ACL to a File .......................... 6-13
Windows: Creating an ACL ..................................................... 6-16
Windows: Deleting Users or Groups from an ACL .................. 6-18
Web: Applying an Existing ACL .............................................. 6-19
Web: Creating a Custom ACL .................................................. 6-19
  Advantages of the Web Interface for Creating ACLs ................ 6-21
Working with Groups .............................................................. 6-22
  Web: Creating a Group ........................................................ 6-22
  Assigning ACLs to Groups .................................................... 6-24
Managing Access to Folders ..................................................... 6-25

Index
Send Us Your Comments

Internet File System User’s Guide, Release 1.1
Part No. A75154-04

Oracle Corporation welcomes your comments and suggestions on the quality and usefulness of this publication. Your input is an important part of the information used for revision.

- Did you find any errors?
- Is the information clearly presented?
- Do you need more information? If so, where?
- Are the examples correct? Do you need more examples?
- What features did you like most about this manual?

If you find any errors or have any other suggestions for improvement, please indicate the chapter, section, and page number (if available). You can send comments to us in the following ways:

- E-mail: ifsdocteam@us.oracle.com
- FAX - 650.506.7104 Attn: Documentation Manager for Internet File System
- Postal service:
  Oracle Corporation
  Internet File System, Attn: Documentation Manager
  500 Oracle Parkway, Mailstop 5op4
  Redwood Shores, CA 94065
  USA

If you would like a reply, please give your name, address, and telephone number below.

If you have problems with the software, please contact your local Oracle World Wide Support Center.
Preface

Oracle Internet File System (Oracle iFS) is a file system and development platform that enhances the power of the Oracle database. From the standpoint of end users and client applications, Oracle iFS behaves as if it were a standard file server, organizing documents into hierarchies of folders.

Oracle iFS contains a number of features designed to manage content effectively. By storing everything from e-mail to spreadsheets in the same file system, Oracle iFS provides one place to edit, store, and publish the content you control.

Intended Audience

This manual is intended for end users of the Oracle Internet File System. It provides an introduction to Oracle iFS, details on using the Windows and Web interfaces, and step-by-step instructions for using the content management features of Oracle iFS. It also describes the security features built into Oracle iFS and how you can control access to your files.

Structure of the User’s Guide

The Oracle Internet File System User’s Guide contains six chapters:

Chapter 1 Introduction to the Oracle Internet File System

Introduces the Oracle Internet File System, discusses the importance of content management, describes how Oracle iFS works, explains what Oracle iFS can do for your company, and gives an overview of the features of Oracle iFS.
Chapter 2  Getting Started with Oracle Internet File System

Provides the information you need to begin using Oracle iFS: configuring your user account and profile, accessing Oracle iFS, understanding the Oracle iFS document structure, and working with the Windows and Web interfaces.

Chapter 3  Managing Files and Folders

Details the file management features of Oracle iFS, including working with document properties and performing searches in Oracle iFS.

Chapter 4  Finding Information in the Oracle iFS Repository

Illustrates ways to find information in Oracle iFS including attribute and content searching.

Chapter 5  Content Management Functions

Describes the content management features of Oracle iFS, including creating multiple document versions, checking files out for modification, and publishing strategies.

Chapter 6  Managing Access to Files

Provides information about using Oracle iFS security features, such as controlling access to documents and setting up Access Control Lists (ACLs).

Related Documents

For more information on Oracle Internet File System, see the following manuals, which are included with the product:

- Oracle Internet File System Installation Guide
- Oracle Internet File System Setup and Administration Guide
- Oracle Internet File System Developer’s Guide

For more information on software required by Oracle Internet File System, see the documentation for the Oracle8i database.

Keyboard Equivalents

The Oracle iFS Windows interface is easy to use, whether you prefer to navigate with the mouse or by entering keystroke commands. On the following interface, for
example, you could type <Alt + F> to open the File menu, or <Alt + i> to activate the Find Now button. Or you could use the mouse to achieve the same result.

*Figure 0–1  The Windows interface can be activated with keystrokes*
Oracle Internet File System (Oracle iFS) is a new way of storing, accessing, and organizing your electronic information in a single place. This chapter gives you a glimpse of Oracle iFS and what it can do for you. Topics include:

- Oracle Internet File System at a Glance
- Comparing Standard File Systems to Oracle iFS
- How Does Oracle iFS Help Me Do My Work Faster?
Oracle Internet File System at a Glance

Oracle Internet File System (Oracle iFS) is a file system in a database. You don’t need to be concerned about dealing with the complexities of a database, because Oracle iFS looks exactly like any other networked drive. However, because Oracle iFS actually stores files in a relational database, rather than on a local hard drive, you can perform many tasks using Oracle iFS that are not possible using standard file systems.

Oracle iFS allows you to work from either a Windows interface or a Web interface. Although each has a unique look and feel, the Windows and Web interfaces perform the same basic functions. Below is a quick overview of what Oracle iFS looks like from each of these interfaces.

In addition, you can access Oracle iFS from:

- E-mail clients
- FTP (File Transfer Protocol) clients
- Web Folders, an addition to Microsoft Explorer that lets you access files and folders through WebDAV. WebDAV (Web-based Distributed Authoring and Versioning) is a set of extensions to the HTTP protocol, which allows users to collaboratively edit and manage files on remote web servers.

Windows Interface

Through the Windows interface, you can view your Oracle iFS files and folders through the Microsoft Windows 95, 98, 2000, and NT operating systems. The Oracle iFS server will be accessible from the My Computer and Network Neighborhood icons on your desktop as well as from Windows Explorer, Microsoft’s file management interface. The Oracle iFS server appears like any other drive in Windows Explorer; for example:
Figure 1–1  The Oracle iFS server appears as a drive in Windows Explorer

In addition, you can install a set of Oracle iFS utilities on your computer to provide special content management features such as check in/check out, versioning, and searching on the contents of files.

Web Interface

All of the functionality of the Windows interface is duplicated in the Web interface. Additionally, basic administrative functions are accessible from the Web interface (if you have administrative permissions). No additional software or utilities are required to access Oracle iFS through the Web interface. You just point your Netscape Navigator 4.7 or Internet Explorer 5 or 5.5 browser to the location of the Oracle iFS server, usually the server name; for example, http://myserver.mycompany.com.
The Web interface is divided into three frames. The Banner, across the top, displays controls that allow you to log out of the Oracle iFS system, access online help, and search for specific files and content.

The bottom left frame displays a Directory Tree showing the hierarchical organization of your Oracle iFS folders, including folders that store security and access information.

The bottom right frame displays the File List for the folder currently selected in the Directory Tree. This list may also include folders. Above the File List is the toolbar, composed of icons representing menus that, when clicked, give you access to Oracle iFS functions.

**The Web Folders Hierarchy**

Using web folders, you arrange content into a hierarchy of folders, just like you do in Windows Explorer. Accessing your data through web folders gives you the ability to modify your content, make versions of files, and use other Oracle iFS functions.
functionality with them. You may also browse, search, and manage web-based Oracle iFS data from a folder hierarchy.

This is how Oracle iFS files are presented when you access them from web folders in Microsoft Explorer. As you can see, web folders appear as another mount point in the Windows Explorer hierarchy.

Figure 1–3  Web Folders appear in Windows Explorer as another mount point

E-mail

Included in your home directory in Oracle iFS is a mail folder containing an inbox. The inbox enables you to save e-mails into Oracle iFS and view them through the Windows and Web interfaces. This, in turn, enables you to include e-mail files and their attachments when you search for data in the repository.

Your system administrator can also configure your e-mail for you to receive your e-mail messages in your Oracle iFS inbox, enabling you to read your e-mail messages without being in an e-mail client. In your e-mail client, you might also map an additional IMAP directory to the Oracle iFS drive.

Versioning and check-in and check-out of files are not permitted for e-mail files.
You can then move or copy messages from e-mail into Oracle iFS. Once in Oracle iFS, messages can be managed and searched along with other data.
FTP

Many people use FTP (File Transfer Protocol) to move their files, especially when uploading revised web pages for publishing on a web server, or bulk uploading files of any type. Your FTP client will treat your Oracle iFS drive as any other drive on your system when uploading and downloading files.

Versioning and check-in and check-out of files are not permitted by FTP.
Comparing Standard File Systems to Oracle iFS

When you use Oracle iFS, you combine the flexibility and ease-of-use of a file system with the reliability of a database. The following chart compares Oracle iFS with standard file systems.

Table 1–1  The features of standard file systems versus Oracle iFS

<table>
<thead>
<tr>
<th>Feature</th>
<th>Standard File Systems</th>
<th>Oracle iFS</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ease of access to files</td>
<td>You may have limited or difficult access to your files from home, depending on corporate firewalls.</td>
<td>Multiple forms of access mean you’ll always be in touch with your information. You can use: - Windows - The World Wide Web - FTP - E-mail - WebDAV</td>
</tr>
<tr>
<td>Integrated Storage</td>
<td>Different types of content often live in specialized servers; e.g., e-mail.</td>
<td>The same directory can store many types of file, such as: - E-mail messages - Web files - Word processing files</td>
</tr>
<tr>
<td>Versioning</td>
<td>If you want to save multiple versions of a file, you must give them unique file names and store them in their own folders. You have to manually organize and maintain your files.</td>
<td>When you save a file, you can choose to keep older versions of the file. Oracle iFS manages the versions for you. All versions are stored in the same directory.</td>
</tr>
<tr>
<td>File access for collaborative projects</td>
<td>Access is all-or-nothing: if your teammates have access to your files, they can overwrite your work. If they don’t have access to your work, they must work on separate copies of your files, which must then be manually combined.</td>
<td>Check-in/check-out allows you to lock files you are working on to protect against other users overwriting your work. Security allows you to decide who should have access to individual files, and whether other users can update them.</td>
</tr>
<tr>
<td>Searching</td>
<td>Files of different types, such as e-mail and word processing files, are stored in separate file systems, so you must perform multiple searches to locate all references to a topic. Content-based searching is slow and difficult.</td>
<td>Multiple file types can be stored together in Oracle iFS. You perform a single search to locate all references to a topic. Content-based searching is not only fast, but sophisticated.</td>
</tr>
</tbody>
</table>
How Does Oracle iFS Help Me Do My Work Faster?

As a user of Oracle iFS, it may be useful to you to know how the features of this product can help you do your work faster and with greater convenience.

Table 1–2  How Oracle iFS helps users work faster

<table>
<thead>
<tr>
<th>Work Requirement</th>
<th>iFS Provides</th>
<th>User Benefit</th>
</tr>
</thead>
<tbody>
<tr>
<td>Accessing and managing files</td>
<td>Universal access to files using familiar interfaces.</td>
<td>You don’t have to learn a new interface in order to work with files stored in Oracle iFS.</td>
</tr>
<tr>
<td>Working on a project that includes multiple types of files</td>
<td>Unified access to multiple types of data.</td>
<td>You don’t have to deal with separate file hierarchies stored in multiple applications. All your files, of whatever type, are visible when you open Oracle iFS. One login provides access to all your files; you have only one username/password to remember.</td>
</tr>
<tr>
<td></td>
<td>Using a single interface, you can store and work with many different types of data:</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Word-processing files</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Spreadsheets</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Web pages</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Audio and video files</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- E-mail messages</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- XML</td>
<td></td>
</tr>
<tr>
<td>Keeping multiple versions of the same file</td>
<td>Versioning</td>
<td>Versioning lets you automatically save earlier versions of each file, and lets you track the development history of the files. If you are unhappy with recent changes to a file, you can access an earlier version of the file, rather than trying to recreate the file from memory.</td>
</tr>
<tr>
<td>Managing file access on a collaborative project</td>
<td>Check-in/check-out and locking</td>
<td>Check-in/check-out lets you restrict when others can edit your files. While you’re working on the file, you check it out; others can read your files, but no one can overwrite your work.</td>
</tr>
<tr>
<td>Searching across multiple file types, such as web pages, e-mail, and word-processing files</td>
<td>Combined searches</td>
<td>Because multiple file types are stored in Oracle iFS, a single search returns a list that includes all file types that match your search criteria.</td>
</tr>
<tr>
<td>Backing up data</td>
<td>Database-level back up</td>
<td>Because Oracle iFS is located in an Oracle database, you can use the data backup and recovery features of the database to protect all of your work files.</td>
</tr>
</tbody>
</table>
Oracle Internet File System (Oracle iFS) is accessible in a number of different ways. The procedural topics in this guide have been tailored by access method. Topics preceded by Windows and the Windows interface icon describe tasks performed using the Windows interface. Topics preceded by Web and the Web interface icon describe tasks performed using the Web interface.

Figure 2–1 Icons denoting Windows versus Web interface topics

<table>
<thead>
<tr>
<th>Icon</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Windows Icon" /></td>
<td>Identifies topics related to using the Windows interface.</td>
</tr>
<tr>
<td><img src="image" alt="Web Icon" /></td>
<td>Identifies topics related to using the Web interface.</td>
</tr>
</tbody>
</table>

The topics labeled FTP and E-mail apply to using the FTP (File Transfer Protocol) and e-mail protocol, respectively. Topics include:

- Overview: Accessing Oracle iFS
- Windows: Accessing Oracle iFS
- Web: Accessing Oracle iFS
- Web Folders
- FTP: Accessing Oracle iFS
- E-mail: Accessing Oracle iFS
Overview: Accessing Oracle iFS

You can access Oracle iFS through:

- Microsoft Windows Explorer
- Microsoft Network Neighborhood
- a web browser
- web folders
- an FTP client
- an e-mail client

You probably have one or more of these tools installed on your machine already.

The next step is to set up an Oracle iFS account in your name, so that you can log in to and use Oracle iFS. Then, if you plan to use the content management features of Oracle iFS through the Windows interface, you need to install the Oracle iFS Utilities on your local drive. These utilities provide access to features such as file versioning, the check-in/check-out functionality, and file locking. You do not need to install Oracle iFS Utilities if you plan to work only with the Web interface.

Setting Up an Oracle iFS Account

Your Oracle iFS account is set up by your system administrator. Ask him or her for your Oracle iFS login and password. You’ll use the same login and password regardless of the way you connect to Oracle iFS.

Your Oracle iFS account includes three default directories for your use:

- `/home/<username>`—Contains private directories and links to other directories. Other people will not be able to see your home directory unless you allow it.
- `mail`—Stores your e-mail files as a subdirectory of your home directory.
- `inbox`—Subdirectory of the mail directory where new messages are stored by default.

Depending on how your administrator configures your Oracle iFS system, you may also have a `public` directory, used to store files common to all users on the system.

Here’s an example of what the default directories look like on the Web interface:
Accessing Oracle iFS through Windows involves mapping a drive to Oracle iFS and installing the Oracle iFS Utilities so that you can use the built-in content management features of Oracle iFS. Mapping the drive involves logging into the Oracle iFS drive; once completed, your connection to the drive remains from session to session. Installing the Oracle iFS Utilities is a one-time-only task. If you don’t want to map a network drive to Oracle iFS, you can also navigate to Oracle iFS via Network Neighborhood.

- Step 1: Map a Network Drive to Oracle iFS.
- Step 2: Install the Oracle iFS Utilities (one time only).

Step 1: Map a Network Drive to Oracle iFS

The first step is to map a network drive to your Oracle iFS directory. Mapping a drive assigns a letter to your Oracle iFS directory (e.g., O:) and enables you to access your Oracle iFS files the same way that you access files on your other local and networked hard disks.

If you do not know the Oracle iFS server path, you can find it by browsing through your Network Neighborhood window. When the Network Neighborhood view is set to Detailed, all Oracle iFS drives are labelled “Oracle Internet File Server.” Once you have found the server, note the path, and you are ready to map a network drive.
drive. You can also contact your system administrator for help in locating your Oracle iFS server.

1. Ask your system administrator for your Oracle iFS login and password. You will need them to log into Oracle iFS as you map the drive.

2. In Windows Explorer, click Tools -> Map Network Drive.

*Figure 2–3 Use Windows Explorer to map a network drive to Oracle iFS*

3. In the Map Network Drive dialog, fill in the text boxes:

*Table 2–1 The Map Network Drive Dialog*

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>Drive Letter</td>
<td>Choose the drive letter you want to assign to the Oracle iFS server. The next drive letter in sequence is selected for you automatically. Unless you want to replace an existing network drive mapping, choose a letter that is not already assigned.</td>
</tr>
</tbody>
</table>
4. Make sure the Reconnect at Logon checkbox is selected. This will automatically remap the Oracle iFS drive whenever you log into your computer.

5. Click OK.

Windows displays a dialog box asking for login and password (provided to you by your system administrator).

6. Type your Oracle iFS user name (ID) and password. If you are connecting from a Windows 95, 98, or 2000 system logged into an Windows NT domain, your Oracle iFS login ID and your domain ID must match. In this case, you can use a different password on the Oracle iFS server from your domain password. Also, from Windows 95 and 98, your client login must match the Oracle iFS login.

---

**Note:** Once you’ve mapped to the Oracle iFS drive, you won’t be asked to log on in subsequent sessions.

---

### Step 2: Install the Oracle iFS Utilities

Although installing the Oracle iFS Utilities is optional, these utilities provide access to content management features such as file check-in/check-out, content-based searching, versioning, locking, and more. You can still connect to Oracle iFS through Windows networking without using the Oracle iFS Utilities.
To install the Oracle iFS Utilities:

1. Close all Windows programs (recommended, but not required).

2. Locate the Setup.exe file, based on instructions from your system administrator. (Under the Mount Points folder on the Web interface, the installation files are located in `root/ifs/winui/install`.)

3. Double-click the filename to run the Setup.exe program, or run it from the Run command in the Start menu.

4. Follow all instructions and accept the defaults unless your system administrator tells you otherwise. Note that you can install a different language version of the utilities than your operating system. For example, you can install the French version of the Oracle iFS Utilities on an English version of Windows.

![Figure 2–4  Windows interface context menu](image)

By default, the Oracle iFS Utilities are installed in the following directory:

```
C:\Program Files\Oracle\iFS
```

5. After you install the utilities, you may be prompted to reboot your machine. Once you’ve installed the Oracle iFS Utilities, the Windows Start menu and the context menu (right-click menu) will include utilities for the Oracle iFS features when you right-click a file or folder on an Oracle iFS drive.
Figure 2–5 Oracle iFS utilities are displayed in the context menu

<table>
<thead>
<tr>
<th>Open</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>New</td>
<td></td>
</tr>
<tr>
<td>Print</td>
<td></td>
</tr>
<tr>
<td>Quick View</td>
<td></td>
</tr>
<tr>
<td>Make File Versioned…</td>
<td></td>
</tr>
<tr>
<td>iFS Check Out</td>
<td></td>
</tr>
<tr>
<td>iFS Check In…</td>
<td></td>
</tr>
<tr>
<td>iFS Lock</td>
<td></td>
</tr>
<tr>
<td>iFS Unlock</td>
<td></td>
</tr>
<tr>
<td>iFS List Parents…</td>
<td></td>
</tr>
<tr>
<td>Scan with Norton AntiVirus</td>
<td></td>
</tr>
<tr>
<td>Add to Zip</td>
<td></td>
</tr>
<tr>
<td>Add to Change List .zip</td>
<td></td>
</tr>
<tr>
<td>Zip and E-Mail Change List .zip</td>
<td></td>
</tr>
<tr>
<td>Send To</td>
<td></td>
</tr>
<tr>
<td>Cut</td>
<td></td>
</tr>
<tr>
<td>Copy</td>
<td></td>
</tr>
<tr>
<td>Create Shortcut</td>
<td></td>
</tr>
<tr>
<td>Delete</td>
<td></td>
</tr>
<tr>
<td>Rename</td>
<td></td>
</tr>
<tr>
<td>Properties</td>
<td></td>
</tr>
</tbody>
</table>
Web: Accessing Oracle iFS

The Oracle iFS Web interface provides a way of accessing and using Oracle iFS via a web browser. The Web interface has the full capabilities of the Oracle iFS Windows interface, and offers additional features.

Accessing Oracle iFS with a web browser requires no special utilities or other browser features (however, you must have Javascript and cookies enabled in your web browser preferences). You should note that Java and ActiveX are *not* required to use the Web interface. Currently, the browsers certified to work with Oracle iFS are:

- Netscape Navigator 4.7
- Microsoft Internet Explorer 5 and 5.5

Logging into Oracle iFS

You log into Oracle iFS by pointing your browser to the Oracle iFS server. The command usually takes the form:

http://<server_name>/ifs/webui/

The `<server_name>` is either the name your system administrator assigned to the Oracle iFS server or the server’s IP address. Ask your system administrator what the exact login URL is. `/ifs/webui/` is the directory that the login page is located in.

When you reach the Login screen, Oracle iFS prompts you for your login and password. Your login and password are assigned to you by your system administrator.
To see an overview of the capabilities of Oracle iFS, click the QuickTour link at the bottom of the screen.

**Parts of the Web Interface**

Once you are logged in, the *Web interface* is displayed. The Web interface has the following components:
Figure 2–8  The Web interface presents easy-to-use icons and tools

Banner
The Banner contains controls for global commands.

- Logout

On the right side of the banner, click the icon on the left to log out of Oracle iFS. Once you’ve logged out, a success message is displayed with a Login button that enables you to log in again or log in as a different user.
Note: Closing the Web interface does not log you out of Oracle iFS. If you point your browser to Oracle iFS within a short period of time, you (or anyone using your web browser) may be returned to your home directory without having to log in a second time. If you are finished using Oracle iFS, it’s a good idea to log out and exit the browser application.

- **Help**
  
  Click the right icon on the right side of the banner to display online help for the Oracle iFS functions. Help is displayed in a separate browser window.

- **Find**
  
  You can enter a string in the Find field, then choose whether to search for file names (Titles) or file contents using the drop-down menu. Oracle iFS lists all of the files matching your criteria in the File List.

- **Advanced**
  
  Click the Advanced link to display the Advanced Search window, which lets you search for files using additional criteria. The Advanced Search window is described in Chapter 3, “Managing Files and Folders”.

**Directory Tree**

The Directory Tree displays a hierarchical list of the available directories to which you have access in Oracle iFS. There are six items installed by default in your Directory Tree. They are described in the table below:

### Table 2–2  Icon types in the Directory Tree

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="User" /></td>
<td>&lt;user&gt; is your login name. Click this icon to display your personal user settings. You can use this screen to change your password.</td>
</tr>
</tbody>
</table>

Note: Closing the Web interface does not log you out of Oracle iFS. If you point your browser to Oracle iFS within a short period of time, you (or anyone using your web browser) may be returned to your home directory without having to log in a second time. If you are finished using Oracle iFS, it’s a good idea to log out and exit the browser application.
## Toolbar

The Toolbar contains icons that are used to perform actions on selected files. If a menu item is disabled (greyed out), you need to select a file or folder before performing that function.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>![userdirectory]</td>
<td><code>&lt;userdirectory&gt;</code> is your home directory. Click this icon to display the subfolders in your Oracle iFS Directory Tree. Folders with a plus (+) symbol have additional subfolders. Click the icon to display the subfolders. When the subfolders are displayed, a minus (-) symbol is appears to the left of the directory name.</td>
</tr>
</tbody>
</table>
| ![Groups] | Groups are lists of users. It is convenient to create groups of users to whom you assign access to your files and folders, so that you don’t have to set security options individually.  
**Note:** If your administrator has not created any groups for you, the Groups icon may not appear in the tree.  
For more information on creating groups, see “Working with Groups” in Chapter 6. |
| ![Users] | The Users icon displays the current list of Oracle iFS users, whom you can add to the groups you create. Users with administrative privileges can change any user’s passwords. For more information on user options, see “Working with Groups” in Chapter 6. |
| ![ACLs] | The ACLs icon lists the Access Control Lists (ACLs) currently available to you. You can assign default ACLs to your files and folders, and create new ACLs to define specific accessibility for users and groups in your Oracle iFS Directory Tree. For more information on file security, see “ACLs and ACEs” in Chapter 6. |
| ![Mount Points] | Mount points list additional points of entry to your Oracle iFS information. These are created by the system administrator. By default, you access your information through your home directory. For more information on mount points, see the Oracle iFS Web Interface Help system, or talk to your system administrator. |
Click this icon to display a menu that enables you to create a new ACL, folder, user (if you have administrative permissions), or group. For information on creating folders, see Chapter 3, "Managing Files and Folders". For information on creating groups and ACLs, see "Working with Groups" in Chapter 6.

- **Edit**

Click the Edit icon to display a menu of file management tasks, including cutting/copying and pasting folders and files and renaming folders and files. You can also view file properties, version history, and the folders in which the file resides, and applying an ACL to a file. For more information on file management, see Chapter 3, "Managing Files and Folders".

- **Upload**

Click the Upload icon to display a menu that enables you to add a file to your Oracle iFS directory by browsing for the file or by dragging and dropping one or more files from your local drives onto a special Upload window. For more information on adding files to Oracle iFS, see Chapter 3, "Managing Files and Folders".

- **Check In/Out**

The Check In/Out icon provides access to content management commands. You can check versioned files out for modification, preventing others from making changes until you check in the file again. You can lock a nonversioned file to prevent anyone (except yourself) from changing or moving the file. You can also make a file versioned. When a versioned file is checked in, Oracle iFS maintains copies of all previous versions, enabling you to go back to an earlier iteration of the file. For more information on content management, see Chapter 5, "Content Management Functions".

- **Delete**
The Delete icon deletes the selected files or folders from the File List. For information on file management, see Chapter 3, "Managing Files and Folders".

**File List**
Use the File List to perform file management tasks.

*Figure 2–10  The Web interface file list*

<table>
<thead>
<tr>
<th>Select</th>
<th>Type</th>
<th>File Name</th>
<th>Status</th>
<th>Size</th>
<th>Date Modified</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>Chapter</td>
<td>N/A</td>
<td></td>
<td>August 11, 2000 11:39:55 AM PDT</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Conference</td>
<td>N/A</td>
<td></td>
<td>August 9, 2000 03:53:22 PM PDT</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Marketing</td>
<td>N/A</td>
<td></td>
<td>August 9, 2000 03:53:22 PM PDT</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Read-only</td>
<td>N/A</td>
<td></td>
<td>August 2, 2000 03:36:47 AM PDT</td>
</tr>
</tbody>
</table>

The File List has the following columns.

- **Select**
  This column displays selection checkboxes. Before performing any of the commands in the toolbar involving existing files, you must first click the corresponding Select check box for the file(s) you want to modify. The Edit menu in the toolbar contains a Select All command to make it easy to select all files.

- **Type**
  An icon shows you the type of the file. You can click the icon or file name to open the file.

*Figure 2–11  File type icons*

<table>
<thead>
<tr>
<th>Type</th>
<th>Icon</th>
</tr>
</thead>
<tbody>
<tr>
<td>Folder</td>
<td><img src="image" alt="Folder Icon" /></td>
</tr>
<tr>
<td>File</td>
<td><img src="image" alt="File Icon" /></td>
</tr>
<tr>
<td>Graphic</td>
<td><img src="image" alt="Graphic Icon" /></td>
</tr>
</tbody>
</table>
## File Name

The name of the file or folder. If the file is a linked file – that is, if it’s accessible from multiple folders – the file name appears in *italics*. For more information on linked files, see Chapter 3, "Managing Files and Folders". If the file is versioned – that is, if a history is maintained of changes to the file – its name appears in **bold** text. For more information on versioned files, see Chapter 5, "Content Management Functions".

## Status

The Status column provides information on the accessibility of a folder or file.

### Table 2–3  Status icons

<table>
<thead>
<tr>
<th>Status</th>
<th>Icon</th>
</tr>
</thead>
<tbody>
<tr>
<td>Available</td>
<td><img src="image" alt="Available Icon" /></td>
</tr>
<tr>
<td>Checked out; you can view the file but cannot update it or check it in (unless you checked it out)</td>
<td><img src="image" alt="Checked out Icon" /></td>
</tr>
<tr>
<td>Locked; you can view the file but cannot update it or unlock it</td>
<td><img src="image" alt="Locked Icon" /></td>
</tr>
<tr>
<td>Locked; you are authorized to unlock the file and work with it</td>
<td><img src="image" alt="Locked with key Icon" /></td>
</tr>
</tbody>
</table>
For more information on content management see Chapter 5, "Content Management Functions".

- **Size**
  The size of the file, in KB (kilobytes) or MB (megabytes) is shown in the Size column. Folders sizes are not shown.

- **Date Modified**
  The date and time of the last change to the file.
Navigating the Folder Hierarchy

There are two methods for navigating the folder hierarchy.

- You can view the contents of a folder by clicking its icon or its name in the File List.
- You can move up or down through the hierarchy using the Directory Tree.

When a folder has subfolders, the icon appears with a plus sign (+) to its left. Click the plus sign to display the folder’s subfolders.

When a folder is displaying its subfolders, a minus sign (-) appears to its left. Click the minus sign to hide the subdirectories of that folder.

For more information on working with files and folders, see Chapter 3, "Managing Files and Folders".
Web Folders

Web folders are an extension to Microsoft Explorer that let you connect to a server via the WebDAV protocol, designed for Internet and intranet collaboration on files. Although Web Folders appear as another network resource in Windows Explorer, such as a mapped network drive or a file server accessed via Network Neighborhood, you in fact use a different protocol – WebDAV instead of SMB – to connect to the server. If you connect to Oracle iFS via Web Folders, you’ll see the same content visible via SMB, a browser, an FTP client, or an e-mail client.

Web folders are currently supported by Microsoft Internet Explorer 5 or 5.5 running on Windows 95/98/NT. On these platforms, you must download and install them. They are automatically installed with MS Office 2000 and Windows 2000, where this feature is called “Save To The Web.” Once installed as an IE5 or 5.5 option, web folders become part of the Windows operating system, and can be accessed from Windows Explorer like other folders, by using IE5 or 5.5 “Open as Web Folder,” or by using Office 2000 applications.

With Office 2000, you can edit versioned files in place. For other files and editors, you may need to edit a local copy, then upload changes via drag-and-drop or copy in Windows Explorer.

Installing Web Folders

Web folders may already be installed on your system. To check, on your Windows desktop click My Computer and look to see if there is a Web Folders icon. If so, go to Step 2. If not, continue with Step 1.
Figure 2–12  Web Folders can be viewed from the My Computer icon

1. Open the Control Panel by clicking Start -> Settings -> Control Panel.
2. In the Control Panel, double-click the Add/Remove Programs icon.
3. In the Add/Remove programs dialog box, scroll down until you see the entry, Microsoft Internet Explorer and Internet Tools.

Figure 2–13  Add/Remove Programs

4. Click the entry to highlight it, then click the Add/Remove button.
5. Select Add a component and click OK.
6. Scroll through the list of installable components and select Web Folders by clicking its checkbox. Make sure you have enough space on your hard drive to install Web Folders (about 3.3 megabytes) then click Next.

![Figure 2-14 Choose the Web Folders check-box](image)

7. Wait for the Windows Update download to complete.

8. When installation is complete, click Finish to return to your desktop.

9. In Windows Explorer, open the Web Folders directory, located under My Computer.

**Adding Web Folders**

1. In Windows Explorer, open the Web Folders directory.

2. Double-click the Add Web Folders icon.

3. At the Type the location to add prompt, type the URL of your Oracle iFS server – for example, `http://myserver.mycompany.com`.

4. Click Next.

5. At the prompt for an ID and password, type your Oracle iFS login and password.

6. Name the web folder.
Working with Web Folders on Your Oracle iFS Drive

You can save any file to your Oracle iFS web folder by copying it or dragging and dropping it. Files you add to the Oracle iFS web folder become part of the repository. You can use the Oracle iFS Utilities to manage these files.

FTP: Accessing Oracle iFS

You can access and use Oracle iFS via File Transfer Protocol (FTP), which is especially useful for transferring large numbers of files. When you use an FTP client to log into Oracle iFS and upload files, the files are stored directly into database tables. But your FTP client, like the other protocols that access Oracle iFS, thinks it’s talking to an FTP server which is writing to a hard drive. You can upload and download files to and from your Oracle iFS server, but cannot version the documents using FTP; therefore, you can’t check out and in files using FTP.

Every FTP tool, whether it has a graphical user interface or is a command line application, asks you for a login and password, which is your standard Oracle iFS login and password. After you connect to Oracle iFS via FTP, Oracle iFS takes you to your home directory. From your home directory, you can navigate through the rest of Oracle iFS, including subfolders in your home directory, other users’ directories (if you have the appropriate permissions), and the public directories.

You can access Oracle iFS in two ways:

- Specify the FTP server by name
- Specify the FTP server by IP address

Ask your system administrator for the name or IP address you need. You may also need to specify the port.

Configuring Your FTP Client

To configure your FTP client to work with Oracle iFS, supply the following information to your FTP client:

- Login: (Oracle iFS user name)
- Password: (Oracle iFS password)
- Port: Oracle iFS uses port 21 as its default FTP port. You can specify a different port (e.g., 2100) if Oracle iFS is configured to use a different port for FTP access.
- Server/Directory: (Name of the Oracle iFS server and directory to which you want to connect)
**Using Anonymous Access**

For anonymous FTP access, use the following:

- Login: anonymous
- Password: (leave the Password field blank)

**FTP Commands Not Supported by Oracle iFS**

The following FTP commands are not supported by Oracle iFS:

- Append
- Store Unique

---

**E-mail: Accessing Oracle iFS**

If your organization decides to use the Oracle iFS server as your mail server, you will still be able to use e-mail the way you are used to using it. All of the day-to-day e-mail functions that you’re accustomed to using work the same as with any other mail server.

The difference is that in addition to accessing e-mail from your usual e-mail application, you can access it through all the protocols, including Windows file sharing, the Web, FTP, and standard e-mail access. The primary advantage to accessing e-mail from Oracle iFS is that all of your files – e-mail, text, images, and so on – can be viewed, searched, and managed from a single interface. This means that if you search for data about marketing statistics in Oracle iFS, your search result will include e-mails that deal with marketing statistics.

Of course, you can still access e-mail from your e-mail application, after it has been configured to point to the iFS server. However, you will only be able to see e-mail files in the e-mail application.

When you log into Oracle iFS, you’ll see a mail folder that, when you click it, takes you to your e-mail inbox. On the Web interface, the mail link is displayed in your File List:

You can create folders in Oracle iFS through your mail client(s) and copy mail messages to them. The messages and attachments are indexed for searching.
On the Windows interface, the mail folder looks just like your other folders:
If you want to access Oracle iFS from your e-mail application, look for the Oracle iFS server name in the Folders list. Here’s how it looks using Microsoft Outlook Express:

![Folder structure](image-url)
The e-mail messages in your Oracle iFS inbox are read only. You will see each message as a separate folder.

**Configuring Your E-mail Application to Use the Oracle iFS Sever**

Before you can access e-mail from the iFS interface, you need to configure your e-mail application, such as Netscape Messenger or Microsoft Outlook Express, to work with Oracle iFS.

If you have set up an e-mail account before, follow the same procedure to set up an account using the Oracle iFS server. If you have not set up an e-mail account before, check with your system administrator to find out what menu includes the command that lets you set up an account. In either case, before you begin to set up your e-mail account, you will need to ask your system administrator for the name assigned to the Oracle iFS server, and for other information.

Although every e-mail application has a slightly different setup procedure, you will probably need the following information to set up your e-mail account:
Table 2–4  E-mail setup information

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>Username/Account</td>
<td>Your Oracle iFS login.</td>
</tr>
<tr>
<td>Password</td>
<td>Your Oracle iFS password.</td>
</tr>
<tr>
<td>Organization</td>
<td>Your company or organization name.</td>
</tr>
<tr>
<td>Identified as/Full Name</td>
<td>The name you want to appear in the From section of all e-mail messages. For example, if your login is <em>jsmith</em>, you may want to print <em>Jane Smith</em> in the header of all your e-mail messages.</td>
</tr>
<tr>
<td>Outgoing mail server</td>
<td>The name assigned to the Oracle iFS server as an e-mail server. This setting may differ from the URL of the server or its name on the Windows network. For example, the server identified as <em>iFSMailServer1</em> on the Windows network may be identified as <em>iFSmailserver1.mycompany.com</em> for e-mail clients. The outgoing mail server and incoming mail server will always be the same.</td>
</tr>
<tr>
<td>Incoming mail server type</td>
<td>Your incoming mail server is an IMAP server.</td>
</tr>
<tr>
<td>Incoming mail server</td>
<td>The name assigned to Oracle iFS server as an e-mail server. For example, <em>iFSmailserver1.mycompany.com</em>. The outgoing mail server and incoming mail server will always be the same.</td>
</tr>
</tbody>
</table>

**Using the Oracle iFS Server for E-mail Access**

Your e-mail is delivered to your mail folder by Oracle iFS. Once you have navigated to your mail folder, you can read and organize your e-mail just as you would using any other e-mail application.

You can also reply to messages, forward them, move them, and delete them as usual.

In addition, your e-mail messages acquire the same attributes that other Oracle iFS files are given.
This chapter describes the file management features of Oracle iFS. It shows how to manipulate files and folders using both the Windows and Web interfaces. Topics include:

- Working with the Folder Hierarchy: An Overview
- Windows: Working with Folders
- Windows: Working with Files
- Web: Working with Folders
- Web: Working with Files
- Using Links to Display the Same File in Multiple Folders
- Windows: Creating a Link
- Windows: Viewing a File’s Parent Folders
- Web: Creating a File Link
- Web: Displaying a Document’s Parents
- Web: Deleting a File Link
- Introduction to File Attributes
- Windows: Working with Attributes
- Web: Working with Properties
Working with the Folder Hierarchy: An Overview

The folder hierarchy is an organizational structure of one or more folders in Oracle iFS. Folder hierarchies organize the repository so that users can browse through it easily. Because different users may want to organize their information in different ways, Oracle iFS allows the creation of multiple folder hierarchies to organize Oracle iFS in different ways to make browsing convenient. For example, the sales, development, marketing, and consulting departments of a company may use different hierarchies.

The initial folder hierarchy is usually set up by the system administrator, but users with administrative permissions may work with the hierarchy. This is especially useful in larger organizations made up of self-managing groups or teams.

Whether you access your Oracle iFS files with the Windows interface, the Web interface, or FTP, the folder structure within Oracle iFS looks the same.

The Default Folders

By default, every user is assigned three folders:

- `/home/<username>`—To hold your private folders and links to other folders.
- `mail`—Contains e-mail sent to you. This folder is located inside your home folder.
- `inbox`—This is a subfolder of the mail folder where new e-mail messages are placed by default.

In addition to these three folders, which are specific to each user, there are two common folders.

- Your administrator may set up a `public` folder to store and organize shared information.
- The `root` folder is the highest level folder in the system, under which all user and system directories are stored.

The `public` and `root` folders and your personal `home` folder are set up as `mount points` (navigable entries in the Directory Tree).
The Home Folder

All users are assigned a home folder named for their user ID. For example, if your username is jdoe, you automatically receive a home folder named /home/jdoe. The home folder is a private storage area where you can store files and other folders. This storage area is a folder in Oracle iFS that is owned by and reserved for you. You have complete control over your home folder and can add files to it up to your designated quota, or space allocation, set by the administrator.

Although files in your home folder are private, you can make them available to other users. A file can be “published” in your home folder by changing the Access Control List (ACL) applied to the file. For more information on file access settings using ACLs, see Chapter 6, "Managing Access to Files".
Figure 3–2  The home folder is a private storage area for your files

The Mail Folder and Inbox
By default, the home folder has a mail subfolder. The mail folder has a subfolder named inbox, which is the default location where all incoming e-mail messages are stored. Once your system administrator sets up your inbox, your e-mail arrives in that subfolder. You can then retrieve your e-mail using an e-mail application that points to your inbox; open the e-mail in the Windows Explorer; or open your e-mail directly from the Web interface. Depending on how you use your mail client, it may set up other folders as required.

Rules for Accessing Folders
- Access to a file is not controlled by the folder’s ACL, but by the file’s ACL. A file within a folder may have a different ACL than the folder.
Windows: Working with Folders

- The folder’s ACL controls whether a user can delete the folder, or add or delete items from the folder.
- The file’s ACL controls who can modify or delete the file.
- To browse to a file, you must have access to the folder it is in. It is possible, however, to search and find a file (assuming you have access) in a folder to which you have no access.

XML and Oracle iFS

All types of files may be stored in the Oracle iFS repository, including XML files. Many XML files contain or refer to a Document Type Definition (DTD), a set of rules to which the tags in the XML file must adhere. The DTD describes which tags and attributes are valid in an XML file, and in what context they are valid. Because Oracle iFS has built-in DTD validation, your XML documents are checked for validity as well as whether they are well-formed. If the file is found to be invalid, Oracle iFS will display an error message and will not upload the file.

---

**Note:** DTD validation is not a default. It must be turned on. Refer to your system administrator for more information.

---

Windows: Working with Folders

In Oracle iFS, you perform all operations on folders exactly the way you are accustomed to doing in other Windows applications. Everything in Windows Explorer works the same whether you’re in the Web Folders section or the regular folder hierarchy. For a quick reminder of how to perform folder operations in the Windows Explorer interface, see the following table.

**Table 3–1 Folder operations**

<table>
<thead>
<tr>
<th>Task</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open a folder</td>
<td>Click the plus symbol (+) to the left of the folder name in the Directory Tree.</td>
</tr>
<tr>
<td>Close a folder</td>
<td>Click the minus symbol (-) to the left of the folder name in the Directory Tree.</td>
</tr>
</tbody>
</table>
Table 3–1  Folder operations

<table>
<thead>
<tr>
<th>Task</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create a new folder</td>
<td>Select the parent for the folder you want to create, then choose File-&gt;New-&gt;Folder. Type the name of the new folder.</td>
</tr>
<tr>
<td>Rename an existing folder</td>
<td>Select the folder, choose File-&gt;Rename. Type the new name.</td>
</tr>
</tbody>
</table>
|                        | **Note:** In this version of the product, you can rename the  
|                        | *home*, *mail*, and *inbox* directories. Oracle strongly recommends that you do not rename these folders because doing so can confuse client applications. |
| Copy an existing folder | Select the folder, press Ctrl, then drag and drop the folder to its new location. If copying to a second disk, drag and drop the folder to the disk. |
| Move a folder         | Select the folder, then drag and drop it to its new location to move to a different folder on the same drive. If moving the folder to another drive, right-click and drag the folder to another drive, then choose Move Here from the Context menu. |
| Delete a folder       | Select the folder, choose File->Delete.                                                      |
Windows: Working with Files

In Oracle iFS, you perform all operations on individual files exactly the way you would in other Windows applications. For a quick reminder, see the following table.

**Table 3–2  File operations**

<table>
<thead>
<tr>
<th>Task</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open a file</td>
<td>Double-click the file.</td>
</tr>
<tr>
<td>Close a file</td>
<td>Choose File-&gt;Close.</td>
</tr>
<tr>
<td>Save a new file</td>
<td>With a file open, choose File-&gt;Save.</td>
</tr>
<tr>
<td>Rename an existing file</td>
<td>In Windows Explorer, choose File-&gt;Rename. Type the new name and press Enter.</td>
</tr>
<tr>
<td>Copy an existing file</td>
<td>In Windows Explorer, select the file, press Ctrl, then drag and drop the file to its new location on the same drive. If you’re copying the file to a different drive, drag and drop the file to the second drive.</td>
</tr>
<tr>
<td>Make a copy of the current file</td>
<td>With the file open, choose File-&gt;Save As.</td>
</tr>
<tr>
<td>Move a file</td>
<td>In Windows Explorer, select the file, then drag and drop it in its new location on the same drive. If moving it to a different drive, right-click and drag the file to the second drive, then choose Move Here from the Context menu.</td>
</tr>
<tr>
<td>Delete a file</td>
<td>In Windows Explorer, select the file, then choose File - &gt; Delete.</td>
</tr>
</tbody>
</table>

Web: Working with Folders

You can create and populate folders using the Web interface. Changes you make to your home folder using the Web interface will be reflected in the Windows interface (the reverse is also true—changes you make in Windows will appear in the Web interface).

Opening a Folder

To open a folder, click its icon or file name in the File List.
You can also use the Directory Tree to navigate up or down your file hierarchy. Click the plus symbol (+) to the left of the folder icon to display its subfolders.

**Closing a Folder**

To close a folder, click the minus symbol (-) to its left in the Directory Tree.

**Creating a New Folder**

To create a folder:
1. Navigate to the folder in which you want to create your new folder.
2. Click the New icon and choose Folder.
3. In the dialog, type the name for your new folder.
4. Click OK.

**Renaming a Folder**

To rename a folder:
1. In the File List, click the Select checkbox to the left of the folder.
2. Click the Edit button and choose Rename.
3. Type the new name for the folder.
4. Click OK.

---

**Note:** You can rename the home, mail, and inbox folders. Oracle strongly recommends that you do not rename these folders because doing so can confuse client applications.

**Copying a Folder**

To copy a folder:
1. Navigate to the parent folder of the folder you want to copy.
2. In the File List, click the Select checkbox to the left of the folder.
3. Click the Edit icon and choose Copy.
4. Navigate to the folder where you want to paste the folder.
5. Click the Edit icon and choose Paste.

Copying a folder in this way makes a second copy of the folder and all its contents. You can also use the Paste as Links command to create a link to the original folder in another location. For more information on creating links, see "Web: Creating a File Link".

**Moving a Folder**

To move a folder:
1. Navigate to the parent folder of the folder you want to move.
2. In the File List, click the Select checkbox to the left of the folder.
3. Click the Edit icon and choose Cut.
4. Navigate to the folder where you want to paste the folder.
5. Click the Edit icon and choose Paste.

Moving a folder in this way relocates the folder in a single location.

**Deleting a Folder**

To delete a folder:
1. Navigate to the parent folder of the folder you want to delete.
2. In the File List, click the Select checkbox to the left of the folder.
3. Click the Delete icon.
4. In the confirmation dialog, click OK to delete the folder.

**Web: Working with Files**

**Opening a File**

To open a file, click the file name or icon of the file. Oracle iFS opens the file with the appropriate application so you can view or edit it on your local operating system.

If you don’t have an application that can display the type of file you have opened, Oracle iFS asks you for a local drive to which to save the file.
To edit a versioned file, you must save it to your local hard drive. To store your changes in Oracle iFS, you must upload the file to add a new version. For more information on versioning files, see Chapter 5, "Content Management Functions".

**Uploading Files**

There are two options for uploading a file using the Web interface. Using the Upload command, you can either upload one file at a time using a file browser window, or you can drag and drop several files at once. If for some reason you cannot use FTP between your computer and the Oracle iFS server, or if your Oracle iFS administrator has not activated the Oracle iFS FTP server, you will need to use the Upload via Browse method.

**Uploading a File Using the File Browser**

To upload using a standard system file browser:

1. Navigate to the folder where you want to store the file.
2. Click the Upload icon and choose Via browse.
3. In the Upload window, click the Browse button.
4. Locate the file you want to upload and click Open.
Figure 3–3  The Upload icon lets you choose the upload method
5. To apply an ACL to the file as it is uploaded, select the ACL you want to use from the drop-down list. You must use an existing ACL.

6. To assign a language to this file, choose from the Language drop-down list. The language feature is not a translator. It applies a set of syntax and grammar rules by which the document can be indexed and searched efficiently.

When Oracle iFS indexes a document, it makes note of terms that it will not search for because they appear too often to yield a relevant search result. These words vary from language to language (like the word *the* in English, *le* in French, *el* in Spanish). The Language you assign to the file helps Oracle iFS index the document correctly and avoid searching for unnecessary terms.

7. In the Character Set menu, choose a character set by which the file can be identified (Western, for example). This provides the character set information by which the file can be correctly indexed for searching. It does not apply to binary files, such as Word documents or Excel spreadsheets, only to text-based files such as XML, HTML, .txt, and .eml files.
Again, this is not a translation feature. It simply provides another indicator by which your file can be correctly indexed. For example, if your character set is German, and you enter jager as a search term, Oracle iFS will search for jäger and jäger.

8. In the Upload window, click the Upload button. The file is added to the File List.

**Uploading a File Using Drag and Drop**

To upload one or more files using drag and drop:

1. Navigate to the folder where you want to store the file.
2. Click the Upload icon and choose Via drag and drop. An FTP client window is displayed, showing the files and folders in the current folder.

*Figure 3–5 The FTP client allows you to drag and drop files to Oracle iFS*

3. Open Windows Explorer.
4. Select one or more files, then drag and drop them to the FTP directory window.
Figure 3-6 The files you upload are displayed in the FTP client window

5. Click OK to confirm that you want to upload the files. If you are uploading multiple files, a progress window appears and lists each file as it is transferred to Oracle iFS.

6. You can continue to drag files onto the Current Directory window to transfer additional files. When you are finished uploading files, close the Current Directory window.

Notes:

- In some browsers, you may not be able to upload folders using this method. You must explicitly create the folders using the procedure for "Creating a New Folder", as described above.

- The Web interface drag-and-drop feature requires that the Oracle iFS FTP server is running. If this feature doesn’t work, ask your system administrator to check that the FTP server is running and, if necessary, start it.
Copying Files

To copy a file:

1. In the File List, click the Select checkbox to the left of the file(s) you want to copy.
2. Click the Edit icon and choose Copy.
3. Navigate to the folder where you want the copied file(s) to appear (which could also be the current folder).
4. Click the Edit icon and choose Paste. If a file by that name already exists, Oracle iFS appends the words "Copy of" to the name of the file.

*Figure 3–7 You can place a copy in the same folder as the original, or another folder*

Copying files in this way creates a second file, separate from the original. You also have the option of working with the same file but listing it in multiple folders using links. For more information on creating links, see "Web: Creating a File Link".
Moving Files

To move a file:
1. In the File List, click the Select checkbox to the left of the file(s) you want to move.
2. Click Edit and choose Cut.
3. Navigate to the folder to which you want to move the file.
4. Click the Edit icon and choose Paste. If a file by that name already exists, Oracle iFS appends the words “Copy of” to the name of the file. You can rename the file(s).

Deleting Files

To delete a file:
1. In the File List, click the Select checkbox to the left of the file(s) you want to delete.
2. Click the Delete icon.
3. In the confirmation dialog, click OK to confirm the delete.

Renaming a File

To change the name of a file:
1. In the File List, click the Select checkbox to the left of the file(s) you want to rename.
2. Click the Edit icon and choose Rename.
3. In the dialog, enter the new name for the file.
4. Click OK to save the file with the new name.

Note: You cannot rename a file with the name of an existing file in the same folder. If you want to replace an existing file with another of the same name, first delete or move the file you want to replace, then rename the second file.
Using Links to Display the Same File in Multiple Folders

Most of the time, the standard file system will meet your needs for storing and organizing your information. For example, you might create a weekly status report and file these reports in a folder called “Status.” You know that you can always find your status report files by going to the Status folder.

However, in some circumstances, the organization of your files is more complex than will fit into a single hierarchy. When the same document fits in a number of categories, you may want the same file to appear in multiple folders. For example, you might want the letter to M. Aloyne about the trade show in Paris to appear in three folders: Letters, Aloyne, and Trade Shows.

You could store the original file, then make copies into the other locations, but to make changes you need to remember to update the file in all three places. Instead, you can create a link to the file in the repository from all three folders.

What are Links?

In Oracle iFS, you can use links to display the same file in more than one folder, eliminating the need to manage multiple copies in multiple locations.

How Links Work

Links shouldn’t be confused with shortcuts in Microsoft Windows. Shortcuts are pointers to a file location, but don’t represent the file itself. If the original file is deleted, the shortcuts remain, but they no longer point to anything.

In Oracle iFS, each Oracle iFS link represents the file equally. If you delete a link from one folder, all of the other links associated with the file remain, and the file isn’t removed. Only when all links have been deleted is the file actually removed from the Oracle iFS repository.

The process for creating a link is similar to that of making a copy of a file and pasting it into another folder (the steps for creating links are described for both the Web and Windows interfaces).

Links created in the Web interface will be visible in the Windows interface, and vice versa. You may need to refresh your windows view or reload your File List in the Web interface before changes made in one interface are visible in the other. In the Web interface, the links appear in italics.
Multiple Parents

Files that are stored in more than one folder are said to have *multiple parents*. When you see a link to a file in a folder, you may want to know what other folders hold links to the same file, especially if you need to keep track of who has access to the file. Both the Windows and Web interfaces include commands that allow you to list a file’s parents. Once you have located the parents you can navigate to the parents for tasks such as changing their security settings or deleting them from Oracle iFS.

*Figure 3–8  The Parents List shows where the selected file resides*

Windows: Creating a Link

To create a link, you locate the file you want to link to, then drag and drop it to the folder in which you want to create the link.

*Note:* Be sure to use the drag and drop method. Do not use the Copy command.
1. In Windows Explorer, select the Oracle iFS file or files.

2. Holding down the right mouse button, drag and drop the file to the folder in which you want the link.

3. In the context menu, click Create Oracle iFS Link Here.

Figure 3–9  Create links using the context menu

4. From the View menu, choose Refresh to see the new link.

Windows: Viewing a File’s Parent Folders

The List Parents function is available from both Windows Explorer and the Start menu.

From Windows Explorer:
1. Right-click the file to display the context menu.
2. Click List Parents.
Figure 3–10  The Oracle iFS List Parents tool is available from the context menu

Oracle iFS displays the List Parents tool and automatically shows you the parents of the folder or file you just right-clicked.

From the Start Menu:
1. Click Programs.
2. From the Programs menu, click Oracle Oracle iFS Utilities.
3. Click iFS List Parents.
4. On the iFS List Parents tool, choose the Oracle iFS drive on which the file resides.
5. Click OK.

6. Click the Browse button to browse for the folder or file whose parents you want to see.

7. Navigate the Directory Tree and click the folder or file for which you want to list parents.

8. Click OK.

9. Click List Parents.

View the Parent Within the Folder Hierarchy

Once you have displayed a folder or file’s parents, you can easily navigate to them in Windows Explorer.

1. On the List Parents tool, click one of the parent folders displayed.

2. Click the Explore button.

Oracle iFS displays the Windows Explorer, highlights the parent folder you selected within the Directory Tree, and shows the content of the folder.
Web: Creating a File Link

To create a file link:

1. Click the Select check box to the left of the file or folder you want to display in another folder.
2. Click the Edit icon and choose Copy.
3. Navigate to the folder in which you want to create the link.
4. Click the Edit icon and choose Paste as links.

If you want to create a link in more than one location:

1. Navigate to the next folder in which you want to create a link.
2. Click Edit and choose Paste as links.
3. Continue until you have created links in all desired locations.

Files with multiple links are listed in *italic* text in every folder (including the original from which you copied). Should the number of links be reduced to one, the name will again appear in plain text. This prevents you from accidentally deleting all links to a file because you thought there were still other links.

Web: Displaying a Document’s Parents

To display a file’s parents:

1. Click the Select checkbox to the left of the file or folder for which you want to display parents.
2. Click the Edit icon and choose Parents.
3. The File List displays a list of the folders that contain instances of the file you selected. Click any of the folder names or icons to go to that folder.

Web: Deleting a File Link

File links are deleted in the same way as any other item in the Web interface.

1. Click the Select checkbox to the left of the file or folder you want to delete.
2. Click the Delete icon.
3. Click OK to confirm the deletion.
When you delete a link, the file remains in Oracle iFS and can still be accessed through any other existing link. When the number of links is reduced to one, the file name appears in plain text, indicating that it is the sole remaining instance of the file. When the last link to a file is removed, the file is deleted from Oracle iFS.

**Introduction to File Attributes**

File management systems store two types of information for every file:

- The content of the file (such as the text of a proposal).
- Information about the file (such as the author and the creation date).

The information about the file is known as its attributes or properties. Oracle iFS uses file attributes to provide additional information and capabilities beyond those of a standard file system. One common use of attributes is to allow quick searches for multiple search criteria. For example, you might search for all word processing files written by T. Frank during May 2000.

Files in Oracle iFS store more attributes than files in standard file systems, enabling you to specify precise search criteria. In this way, you can locate the file you want quickly and accurately.

**Working with Custom Attributes**

In addition to the default attributes that Oracle iFS assigns to every file (name, creator’s name, creation date, description, and so on), your system administrator can opt to create custom attributes. If so, you may be able to search for data using those attributes. For information on whether custom attributes have been created, contact your system administrator.

**Windows: Working with Attributes**

To view a file’s attributes in Windows:

1. Right-click the file.
2. Select Properties from the drop-down menu.
3. In the Properties window, click the Oracle iFS Attributes tab.
Figure 3–12  File attributes can be viewed from the iFS Attributes tab

The iFS Attributes tab is divided into five sections:

Table 3–3  Sections of the iFS Attributes tab

<table>
<thead>
<tr>
<th>Section</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Owner</td>
<td>Lists the owner of the file. This is the login of the person who controls access to this file (this may not be the same person as the creator, who first inserted the file into Oracle iFS).</td>
</tr>
<tr>
<td>File Name and Description</td>
<td>The name of the file. Provides a text field for an abstract description of the contents of the file.</td>
</tr>
<tr>
<td>File Attributes</td>
<td>Lists attributes specific to this file type.</td>
</tr>
</tbody>
</table>
Windows: Working with Attributes

Managing Files and Folders 3-25

Table 3–3  Sections of the iFS Attributes tab

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ExpirationDate</td>
<td>Used to specify that Oracle iFS should delete the file in ( n ) days.</td>
</tr>
<tr>
<td>Language</td>
<td>Shows the language associated with the file.</td>
</tr>
<tr>
<td>Character Set</td>
<td>Shows the character set associated with the file.</td>
</tr>
</tbody>
</table>

iFS Attributes Tab: File Attributes

This table lists the file-specific attributes you will see on the Oracle iFS Attributes tab.

Table 3–4  File Attributes

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CreateDate</td>
<td>Date the file was created, in the format appropriate for the language in which your Web interface is displayed. For example, U. S. English dates may be displayed as MMMM DD, YYYY, hh:mm AM/PM. For example, April 1, 2000, 11:45 AM.</td>
</tr>
<tr>
<td>Creator</td>
<td>The person who first stored this file in Oracle iFS.</td>
</tr>
<tr>
<td>DefaultVersionDescription</td>
<td>The current version description (if a versioned file).</td>
</tr>
<tr>
<td>ExpirationDate</td>
<td>If an expiration date has been set for this file or folder, the expiration date is shown. If no expiration date is set, the field displays (null).</td>
</tr>
<tr>
<td>LastModifier</td>
<td>The login of the last person to change the file.</td>
</tr>
<tr>
<td>LastModifyDate</td>
<td>The date the file was last modified, in some combination of DDDD, MMMM DD, YYYY, hh:mm:ss AM/PM, depending on the language of the Web interface you are working with. For example, Sunday, April 2, 2000, 12:15:22 PM.</td>
</tr>
</tbody>
</table>
Note that the number of attributes displayed may vary, depending on whether any custom attributes have been defined by your system administrator.

### Changing Attribute Values

Some file attributes can be changed on the Oracle iFS Attributes tab; most cannot. The following table summarizes which attributes can be changed (by users with appropriate access privileges), in sequence by their location on the Attributes tab:

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>LockState</td>
<td>A code representing whether the file is available for use, or checked out, or locked. 0 = Unlocked; anyone with the proper permissions may use the file. 1 = Locked; no modifications or deletions are allowed, but anyone with lock and update permissions can unlock it. 3 = Locked; no modifications or deletions are allowed by anyone other than the user or administrator holding the lock. 4 = Locked; no modifications or deletions may be made. The administrator may unlock it.</td>
</tr>
<tr>
<td>Read by Owner</td>
<td>Used by e-mail to show that the file has been read by the owner.</td>
</tr>
<tr>
<td>Language</td>
<td>The language used in the file. When you specify the language, you enable language-sensitive indexing and searching for this file.</td>
</tr>
<tr>
<td>Character set</td>
<td>The character set associated with the file. If you upload a file in German, for example, you should change the language to German and choose the appropriate character set. Character set attribute applies only to text-based files such as HTML, XML, .txt, and .eml, not to binary files like Word and Excel.</td>
</tr>
<tr>
<td>PrimaryVersionSeries</td>
<td>The version number of the file. If the file is not versioned, this field is not displayed.</td>
</tr>
</tbody>
</table>
Setting an Expiration Date

If you own the file, or if you have been granted the appropriate permissions, you can set an expiration date for the file on the iFS Attributes tab. The expiration date is the date on which Oracle iFS deletes the file.

To set an expiration date:

1. On the Oracle iFS Attributes tab of the Windows Properties dialog, click the checkbox next to the Allow File to Expire prompt.
2. Type the number of days until the file should expire.
3. Click OK.

On the date of expiration, the file is permanently removed from the Oracle iFS repository. If this is set through the Windows interface, the file will expire at 12:01AM on the expiration date.

If you do not want a file to expire, make sure that the Allow File to Expire check-box is unchecked.

---

### Table 3-5  Editable Attributes

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Description</td>
<td>The Description can be changed, using the text box provided. You can search files for the text of the description.</td>
</tr>
<tr>
<td>Expiration Date</td>
<td>By selecting the Allow File to Expire in check-box, and entering a number of days, you can edit expiration date from the iFS Attributes tab.</td>
</tr>
<tr>
<td>Language</td>
<td>You can edit the language to be used for indexing.</td>
</tr>
<tr>
<td>Character Set</td>
<td>You can also edit the character set applied to this file.</td>
</tr>
</tbody>
</table>
Web: Working with Properties

The file attributes in the Web interface are similar to those in the Windows interface. This table lists the standard properties you can expect to see in the Web interface for any file.

Table 3-4 File Properties

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Document</td>
<td>The path to the file or object.</td>
</tr>
<tr>
<td>Class Name</td>
<td>The type of file or object.</td>
</tr>
<tr>
<td>Name</td>
<td>The name of the file or object.</td>
</tr>
<tr>
<td>Description</td>
<td>An optional space where the author can place a description of the file or object (may be modified).</td>
</tr>
<tr>
<td>Owner</td>
<td>A list of users to whom you can assign ownership. Displays as currently selected the user ID of the person or group who currently has ownership of the file or object (may be modified).</td>
</tr>
<tr>
<td>ACL</td>
<td>The Access Control List currently associated with the file.</td>
</tr>
<tr>
<td>CreateDate</td>
<td>Date the file was created, in the format appropriate for the language in which your Web interface is displayed. For example, U. S. English dates may be displayed as MMMM DD, YYYY, hh:mm AM/PM. For example, April 1, 2000, 11:45 AM.</td>
</tr>
<tr>
<td>Creator</td>
<td>The login person who first stored this file in Oracle iFS.</td>
</tr>
<tr>
<td>ExpirationDate</td>
<td>The date and time that the file will expire and be deleted from the Oracle iFS repository. If an expiration date has been set for the current file or folder, the expiration date is shown. If no expiration date is set, the field displays (null).</td>
</tr>
</tbody>
</table>
### Table 3-4  File Properties

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>LastModifyDate</td>
<td>The date the file was last modified, in some combination of DDDD, MMMM DD, YYYY, hh:mm:ss AM/PM, depending on the language of the Web interface you are working with. For example, Sunday, April 2, 2000, 12:15:22 PM.</td>
</tr>
<tr>
<td>LastModifier</td>
<td>The login of the last person to change the file.</td>
</tr>
<tr>
<td>Deletor</td>
<td>If the file or object has been deleted, the person who last deleted the file or object.</td>
</tr>
<tr>
<td>LockState</td>
<td>A code representing whether the file is available for use, or checked out, or locked.</td>
</tr>
<tr>
<td></td>
<td>0 = Unlocked; anyone with the proper permissions may use the file.</td>
</tr>
<tr>
<td></td>
<td>1 = Locked; no modifications or deletions are allowed, but anyone with lock and update permissions can unlock it.</td>
</tr>
<tr>
<td></td>
<td>3 = Locked; no modifications or deletions are allowed by anyone other than the user or administrator holding the lock.</td>
</tr>
<tr>
<td></td>
<td>4 = Locked; no modifications or deletions may be made. The administrator may unlock it.</td>
</tr>
<tr>
<td>Read by Owner</td>
<td>Used by e-mail to show that the file has been read by the owner.</td>
</tr>
<tr>
<td>Language</td>
<td>The language used in the file. When you specify the language, you enable language-sensitive indexing and searching for this file.</td>
</tr>
<tr>
<td>Character set</td>
<td>The character set associated with the file. If you upload a file in German, for example, you should change the language to German and choose the appropriate character set. Character set attribute applies only to text-based files such as HTML, XML, .txt, and .eml, not to binary files like Word and Excel.</td>
</tr>
</tbody>
</table>

Note that the number of properties displayed may vary, depending on whether any custom attributes have been defined for a custom file type.
Viewing and Editing File Properties

To view and edit file properties in the Web interface:

1. Click the Select check box to the left of the file or folder for which you want to view properties. You can view properties on only one item at a time.

2. Click the Edit icon and choose Properties.

3. The Document Properties window is displayed. Attributes that can be changed will have a text box in the right column. You can change these values only.

4. When you have finished entering your changes, click OK.

5. Click OK to close the window.

Setting an Expiration Date

If you own a file, or if you have been granted the appropriate permissions, you can set an expiration date for the file on the File Attributes screen.

To set an expiration date:

1. Click the Select checkbox to the left of the file or folder for which you want to set an expiration date.

2. Click the Edit icon and choose Properties.

3. The Document Properties window is displayed. Scroll down to view the Expiration Date field.

4. Type the new Expiration Date.

You can also enter the Expiration Date using the Calendar pop-up. This can be convenient when you want to have the file expire, for example, "on a Friday, two months from now," but don’t know the precise date.
Figure 3–13  Use the Calendar pop-up to set expiration date

To set a date using the Calendar pop-up, click the calendar icon to the right of the Expiration Date field. Once the calendar is displayed, you can set the date using a number of methods:

- Use the drop-down list to set the month.
- Use the double arrows to move back a year (<<) or forward a year (>>).
- Use the single arrows to move back a month (<) or forward a month (>).
- Click any day in the calendar to set the Expiration Date and close the Calendar pop-up.

5. When you have finished entering your changes, click OK.
6. Click OK to close the window.
Finding Information in the Oracle iFS Repository

The Oracle iFS Find utility allows you to search for files and text in Oracle iFS more efficiently and using more sophisticated criteria than with the Windows Find utility. And because the Oracle database’s powerful interMedia Text option is built into Oracle iFS, you also have the advantage of being able to search the contents of files, rather than just the file attributes, when you use the Web interface.

This chapter describes how to perform basic and advanced searching using the Oracle iFS Find utility. Topics include:

- Finding Information: An Overview
- Types of Searches in Oracle iFS
- Windows: Finding Oracle iFS Files
- Web: Finding Files in Oracle iFS
- Custom Searches in Oracle iFS
Finding Information: An Overview

To facilitate efficient searches of large amounts of data, Oracle iFS allows you to search by keyword(s), date(s), and other criteria. More importantly, you can combine search criteria, to ensure that you find the most relevant data quickly.

Your searches can be based on file attributes, such as the file name, file size, language, or date created. In addition, you can search the content of the file. If your e-mails are stored in Oracle iFS, your search will encompass both the e-mail message and any attachments. You can search specific elements of a file, such as its headings or tags. You can also look for themes, information that describes what the document is about, even if your search terms are not included in the document itself.

Many of your search terms will be saved automatically, so that during a session you can reuse them without having to re-enter them.

When a search result is returned, you’ll see each file that:

1. matches your criteria, and
2. you have appropriate permissions to view or work with.

If the file you are searching for is versioned, by default, only the latest version is returned with the search result. However, you can change this option to include all versions.

Types of Searches in Oracle iFS

Oracle iFS lets you conduct a search on the following elements of a file:

- **File Attributes.** Attribute searching allows you to find a file based on the metadata that describes it – file name, author’s name, date the file was created, language it was written in, and more.

- **Content of the file.** Content searching means searching for any word or phrase in the body of the file. You can conduct a content search only if the Oracle interMedia Text option is installed on your server.

- **Theme of the file.** Theme searching lets you retrieve files using search terms that do not necessarily appear in the title or body of the file you’re looking for. Theme searches also require Oracle interMedia Text, and can be performed on documents only in U.S. English.
About Attribute Searching

Oracle iFS allows you to search for pre-defined file attributes, or metadata. When you search for an attribute, you are not searching the body of the document. To conduct an attribute search, you can use keywords, menus and multiple-choice indicators, or a combination of criteria. The attributes you can search for include:

- name of the person who created the file
- description of the file
- date the file was created
- date the file was last modified
- expiration date of the file
- size of the file
- status (checked in/checked out, locked/unlocked) of the file
- language in which the file was written
- character set in which the file was written (Western, for example)

You may also be able to search for custom file attributes defined by your system administrator. For example, if your administrator creates an attribute named doc type to keep track of file extensions (.doc, .xls, .fm), you will be able to use this attribute to limit your searches to files created in a particular application.

About Content Searching with Oracle interMedia Text

When the Oracle interMedia Text option is installed on your server, you have a powerful tool that allows you to search the body of the document, rather than just the metadata, for specific criteria. For example, you might want to locate files containing the phrase marketing analysis somewhere in the text.

Both the Windows and the Web interfaces make it easy to search for specific content. To do so, you construct a keyword search as you normally would, but indicate that you want Oracle iFS to search on the content of the document.

To search for content, you can enter a single word, a group of words, a phrase such as marketing analysis, or any other keyword combination.
You can combine content searches with other types of search to achieve very specific results.

**About Theme Searching with Oracle interMedia Text**

A *theme* is simply what the document is about. When you search for themes, you enter search terms that describe the subject matter, but may not appear in the document you’re looking for. Theme searches use the ABOUT operator, either alone or in combination with Boolean operators. They are conducted from the Web interface only.

Oracle iFS performs the search based on rules that allow it to locate documents that may be relevant to the theme you entered. Before you conduct a theme search, you should check with your system administrator to see if this option is available.

**Note:** For the current release, theme searching applies only to documents written in U.S. English.

To conduct a theme search, you’ll type a search query (e.g., ABOUT microprocessors, ABOUT ‘browsing the internet’) into the File Contents field of Advanced Find window on the Web interface.
Windows: Finding Oracle iFS Files

With the Windows interface, you begin your search by right-clicking the folder or drive you want to search. The Find on iFS utility is displayed in the context menu.

**Note:** When you use the Windows interface, you cannot search more than one mount point (mounted drive) simultaneously.

![Figure 4-1](image)

**Figure 4–1  The Find on iFS utility lets you search the selected drive**

**Note:** The Oracle iFS Find utility can be used only on Oracle iFS drives. For other Windows drives, you should continue to use the standard Windows Find utility.

The Windows Find utility is able to perform searches on Oracle iFS drives, but does so very slowly and its use is not recommended.

After you click Find on iFS, a dialog is displayed. On this dialog, you will set the search criteria using one or more of the four tabs provided:
Figure 4–2  The iFS Find tabs help you construct a variety of searches

You can perform a simple search, or build a complex search by selecting multiple search criteria from the four tabs:

Table 4–1  Search functionality of the iFS Find tabs

<table>
<thead>
<tr>
<th>Search Type</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name &amp; Location</td>
<td>Lets you set the folder in which you want the search to take place. You can search by Name, Description, and/or Owner. You can also restrict searches to specific drives or folders.</td>
</tr>
<tr>
<td>Date</td>
<td>Lets you search for files based on the creation date, modification date, or expiration date. You can search for dates in a given range, or dates within a given day or month from the current date. Also allows you to search all files regardless of date.</td>
</tr>
<tr>
<td>Advanced</td>
<td>Lets you search for files based on their type or size.</td>
</tr>
<tr>
<td>Content</td>
<td>Lets you search for a keyword or text string within the body of a file, and lets you choose the language in which the file was written.</td>
</tr>
</tbody>
</table>

Note that the data entry fields on the screen are also drop-down lists. Oracle iFS will retain the search terms you use in a given session so that you can reuse them during that session.
By default, search fields are not case sensitive; a search for *statistics* will also yield *Statistics*. However, you can change this default by selecting the Options menu at the top of the window, and choosing Case Sensitive.

The Options menu also lets you indicate whether you want the search to return all versions of a matching file. If so, choose Search All Versions.

*Figure 4–3  The Options menu helps customize your searches*

The iFS Find dialog also presents three buttons on the right. These buttons are available for every tab you work in:

- **Find Now** initiates the search after you have chosen all your criteria.
- **Stop** cancels the search in progress, but does not remove your criteria.
- **New Search** removes criteria from a previous search and lets you begin entering new data.
Windows: Searching by File Name and Location

The Name & Location tab allows you to locate files by name, description, or owner.

1. Right-click your Oracle iFS drive or a folder that you believe contains the file. Be sure you click the drive or folder, not the file you want to search.

2. From the context menu, choose Find on iFS...
   You can also select Oracle iFS Find by opening the Start menu. When you do so, you have two options:
   - You can select Programs, and click Oracle iFS Utilities. From the menu displayed, choose iFS Find.
   - Or you can choose Find, then select On Oracle iFS. If you use this option, you must manually specify the drive and folder you want to search.

3. To search by the file name or text you think is in the file name, type it in the Named field of the Name & Location tab.

4. The Description field lets you search for text that was used to describe the file when it was created or modified.

5. The Owner field lets you specify the owner of the file.

Figure 4–4  The Name & Location tab provides several search options
6. If you want to change the folder in which the search will be conducted, select another folder from the Look In menu, or click the Browse button.

7. To search in subfolders of the selected folder, leave the Search in Subfolders box checked. Otherwise, remove the check mark.

8. If you’re ready to search without adding any other criteria, click the Find Now button.

The results of the search are displayed in a list beneath the search criteria tabs. Of the results matching your search criteria, this list contains only those files you have permissions to view and work with.

If you are not ready to search, select another tab and continue entering criteria. Or click the New Search button, which resets the search criteria and lets you create an entirely different search.

**Windows: Searching By Date Criteria**

On the Date tab, you can either search for all files, regardless of date, or you can set search criteria based on a specific date or range of dates.

*Figure 4–5 Use the Date tab to search for modification, creation, or expiration dates*
The Date tab provides the options listed in the table below.

### Table 4-2  Date tab options

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>All Files</td>
<td>The default setting is to search for all files regardless of date.</td>
</tr>
<tr>
<td>Find all files with</td>
<td>Use this drop-down list to choose which of the date attributes should be used for the search. Options are Modification, Creation, or Expiration date.</td>
</tr>
<tr>
<td>between</td>
<td>If you clicked Find all files with, you can click between and enter a date range, within which the file was modified, created, or expired. The first field sets the starting date, the second field sets the end date for the range.</td>
</tr>
<tr>
<td>during the previous</td>
<td>Two fields are available to let you set a search backward for a specific number of months or days, if you clicked Find all files with. These values cannot be used in a search for expiration dates, since any files that expired before the current date have been removed from the repository.</td>
</tr>
</tbody>
</table>

In the Between fields, you can type in the dates or use the calendar pop-up. To use the Calendar pop-up:

1. Click the arrow to the right of the Start or End date field.
Figure 4–6  The Calendar pop-up lets you set date ranges

2. Use the arrows at the top of the calendar to navigate to the month and year.

3. Click the day to set the value and close the Calendar pop-up.

Windows: Searching by File Type and Size

The Advanced tab lets you set search criteria for the file type and size.
Figure 4–7  On the Advanced tab, set file type and size criteria

This tab provides the following options:

Table 4–3  Options on the Advanced tab

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Of type</td>
<td>The type field is set by selecting a file type from the drop-down list. You can choose either Document or Folder.</td>
</tr>
<tr>
<td>Size is</td>
<td>There are three settings for the size criterion. The first drop-down list sets a comparison operator: you can search for a file that is at least, or at most, the size you set. The second field is a rolling counter that lets you set the size by typing in a whole number or by using the up and down arrows to set the value. The third field is a drop-down list that lets you set the unit of measurement to KB (kilobytes), MB (megabytes), or GB (gigabytes).</td>
</tr>
</tbody>
</table>
Windows: Searching by Content Criteria

The Content tab lets you enter a text string on which to search the contents of the files in Oracle iFS. If you want to further limit your search, you can also indicate the language of the document in which the text string was written.

Content criteria allow you to quickly search through the body of a file or files for specific text. However, Oracle interMedia Text must be installed and configured on your Oracle iFS server before you can conduct content searches.

Figure 4-8 The Content tab

1. In the Find Document field, accept the default contains.

2. Type the string you are searching for in the Text field. The field is also a drop-down list. You can recall any of the strings you’ve entered in the current session by clicking the arrow at the right edge of the field and selecting the value you want to use.

3. From the Using Language drop-down list, you have the option of selecting the language of the text you entered in the Text field. This allows Oracle interMedia Text to apply the text processing rules that apply to a particular language.
**Note:** Selecting a language on the Content tab does not restrict the search to documents written in that language. However, if you don’t select a language, you may receive fewer relevant documents in your search result.

---

**Windows: Executing the Search**

Once you have set all the desired criteria in the four tabs of the iFS Find dialog, click the Find Now button to execute the search. The results are displayed beneath the search criteria tabs. Oracle iFS displays all the files that match all the criteria you specified. In this way, you can perform very targeted searches.

*Figure 4-9  Documents can be opened from the search result list*

Double-click any file to open it. You can also right-click any file in the list to activate any Oracle iFS functionality, and you can drag and drop any file out of the result list to another location.
Web: Finding Files in Oracle iFS

To conduct a simple search in Oracle iFS, you will use the Find field in the banner of the Web interface. You can search for a text string in the title or body of a file directly from the banner. When you choose to search the entire body of the document, you are performing the same search as you do in the Content tab of the Windows interface search dialog.

*Figure 4–10* Use the Find field to conduct simple searches

You can also execute a more complex search using the Advanced iFS Find window. If your system administrator has implemented custom attributes, you may also be able to search on those attributes from this window, along with the ones provided for the advanced search. This is what the window looks like when you first open it.

*Figure 4–11* The Advanced iFS Find feature facilitates more complex searches

To understand all the options available from this window, click the arrow next to More Choices and select Add All Options. The window expands to display more search options:
You also have the option of selecting fewer choices, using the drop-down menu on the bottom right.

On this screen, you will use the File Contents field to conduct a search of the document's content. Again, if you want to search for a specific phrase, you must enclose the phrase in single quotation marks. Otherwise, Oracle iFS will search for every word in the phrase, and will return documents that contain each one, regardless of their relationship to each other.

**Web: Performing a Basic Search**

To find a file in Oracle iFS:

1. Select the folder you want to search.
2. In the Find field on the banner, enter the string on which you want to search.
3. To search by file name, choose In Title from the drop-down menu to the right of the Find field. To search for text in the body of a file, choose In Document from the drop-down menu. The language used in the search is the default language of the Oracle iFS server.

Notes:

- If your Oracle iFS server installation does not include the interMedia Text option, you will not be able to use the In Document search feature.
- You can use Boolean operators in the Find field, except for ABOUT and WITHIN.
- Do not use wildcards (* or ?) in the Find field.
- Searches using In Title are not case sensitive.

4. Click the Find icon (the pointing finger). A list is displayed, showing files whose title or contents contain your text string, along with a count of how many files were retrieved. Click any link to open a file.
Web: Performing an Advanced Search

The Advanced iFS Find window allows you to search on additional file attributes using a wider range of criteria. For example, you can search not only on the file name, but also on the date the file was last modified. You can search for files modified before or after a certain date, or within a day, a week, or a month of the date you specify.

Custom attributes defined for your files are displayed in the More Choices list.

Access the Advanced iFS Find window by clicking the Advanced Find link located beneath the Find field on the banner.

Figure 4–15 The Advanced iFS Find window presents more search options

Adding and Removing Search Criteria Fields

By default, the Advanced Find window displays only the Name field. You can add or remove search criteria fields using the More/Fewer Choices drop-down lists.

To add a search field, choose the field or Add All Options from the More Choices menu.
Figure 4–16  Adding a search field

The Advanced Find window displays the selected field with the appropriate selection menu. In Figure 4-10, the available choices refer to the date the file was created.

Figure 4–17  The Date Created field

To remove search criteria fields, choose the appropriate field name or select Remove All Options from the Fewer Choices list.
Figure 4–18  The Fewer Choices menu lets you remove search options

Executing the Find Command

Once you have selected the fields on which you want to search and have entered the values you want to find, click the Find button to execute the search. Oracle iFS examines the directories and files to which you have access and displays the items that match your criteria in the File List. You can continue to modify the settings in the Advanced Find window to increase or decrease the scope of your search to achieve the desired results. When you have finished searching for your files, close the Advanced Find window.
Search Criteria on the Advanced iFS Find Window

These are the attributes on which you can search using Advanced iFS Find:

*Table 4–4  File attributes that can be searched include name, creation date, and content*

<table>
<thead>
<tr>
<th>Attributes</th>
<th>Comparison Operators</th>
<th>Criteria</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name, Creator</td>
<td>contains, starts with, ends with, is, is not</td>
<td>A text string.</td>
</tr>
<tr>
<td>Date Created,</td>
<td>is, is not, is before, is after, is within 1 day of, is within 2 days of, is within 3 days of, is within 1 week of, is within 2 weeks of, is within 3 weeks of, is within 1 month of, is within 2 months of, is within 3 months of, is within 1 year of</td>
<td>A date in the format MM/DD/YYYY.</td>
</tr>
<tr>
<td>Date Modified</td>
<td></td>
<td></td>
</tr>
<tr>
<td>File Contents</td>
<td>contains</td>
<td>Text string.</td>
</tr>
<tr>
<td>(File) Size</td>
<td>is about, is greater than, is less than, is greater than or equal to, is less than or equal to</td>
<td>An integer value. Use the drop-down to select Bytes, KBytes, MBytes, GBytes, or TBytes as the unit of measure.</td>
</tr>
<tr>
<td>Status</td>
<td>status is</td>
<td>Select checked-in or checked-out from the drop-down list.</td>
</tr>
<tr>
<td>Search Folder</td>
<td>is</td>
<td>A folder path.</td>
</tr>
</tbody>
</table>

In addition, you can use the Advanced Search Capabilities box to choose specific types of content to search. For example, you can choose to search for documents, mail messages, folders, and mail folders. Using the More Content Type Options drop-down menu, you can add other options, including description, lock state, and flags.
Custom Searches in Oracle iFS

The Web interface of Oracle iFS gives you the ability to make your searches more efficient by creating custom queries with Boolean operators. You can conduct custom searches from the File Contents field of the Advanced Find window on the Web interface.

Specifically, you can create searches based on:

- Theme, even when the theme is not explicitly stated in the document. Theme searches use the ABOUT operator.
- Specific document sections, such as headings, tags, sentences, and paragraphs. Section searches use the WITHIN operator.

Custom searches apply only when you are searching for file content, not when you search for file attributes.

Before conducting a search with the Web interface, you may want to review basic search techniques with Boolean operators.
Custom Searches in Oracle iFS

Common Search Operators

The following table shows commonly-used Boolean operators and some examples of how to use them:

<table>
<thead>
<tr>
<th>To Search For:</th>
<th>Use Operator:</th>
<th>Examples:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Both Term A and Term B, where the term occurring least frequently is considered more relevant</td>
<td>AND</td>
<td>program AND application</td>
</tr>
<tr>
<td>Either Term A or Term B</td>
<td>OR</td>
<td>program OR application</td>
</tr>
<tr>
<td>Both Term A and Term B, where you want both terms to carry equal weight in determining the relevance</td>
<td>EQUIV</td>
<td>program EQUIV application</td>
</tr>
<tr>
<td>Term A, but not in documents where Term B occurs even once</td>
<td>NOT</td>
<td>program NOT application</td>
</tr>
<tr>
<td>Term A, but with less relevance given to documents where Term B occurs</td>
<td>MINUS</td>
<td>program MINUS application</td>
</tr>
<tr>
<td>Term A when it is near Term B</td>
<td>NEAR</td>
<td>program NEAR application</td>
</tr>
</tbody>
</table>

When you construct a Boolean search in Oracle iFS, the operators must be in CAPITAL LETTERS.

To search for a phrase, use single quotation marks around the phrase: for example, ’desktop application’.

You can also combine search terms. For example, searching for:

    program AND ’desktop application’

will yield results where the term program and the phrase desktop application both appear in the content of the file.

Advanced Search Operators

The two principal operators that greatly extend Oracle iFS search capabilities are WITHIN and ABOUT. ABOUT is used to activate theme searches; WITHIN lets you search specific sections of a document, such as headings, paragraph text, or HTML and XML tags.
ABOUT can be used either with a single word or with a phrase enclosed in single quotation marks, as shown in Table 4-2.

### Table 4–6  Advanced search operators facilitate specialized searches

<table>
<thead>
<tr>
<th>To Search For:</th>
<th>Use Operator:</th>
<th>Examples:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Text within a section or tags of an XML or HTML document that has not been parsed</td>
<td>WITHIN</td>
<td>WITHIN Headings</td>
</tr>
<tr>
<td></td>
<td></td>
<td>WITHIN HTML / XML Tags</td>
</tr>
<tr>
<td></td>
<td></td>
<td>WITHIN Sentences</td>
</tr>
<tr>
<td></td>
<td></td>
<td>WITHIN Paragraphs</td>
</tr>
<tr>
<td>Themes of a document</td>
<td>ABOUT</td>
<td>ABOUT interfaces</td>
</tr>
<tr>
<td></td>
<td></td>
<td>ABOUT 'interface design for desktop applications'</td>
</tr>
</tbody>
</table>

**Web: ABOUT and WITHIN Searches**

On the Web interface, you will conduct custom searches in the File Contents field of the Advanced iFS Find window.

1. On the Web interface banner, choose Advanced Find.
2. Select File Contents from the More Choices drop-down menu. The File Contents and Language fields will be displayed in the window above.
3. Enter your search query and any other data you require.

4. Click Find. Your results will be displayed in a list, along with the number of relevant results.

**Figure 4–20** Custom searches use the File Contents field on the Web interface
This chapter covers Oracle iFS’s content management functions. Topics include:

- Overview of Oracle iFS Content Management
- Introduction to Versioning
- Windows: Making a File Versioned
- Windows: Viewing a File’s Version History
- Windows: Accessing a Previous Version of a File
- Windows: Removing Versions
- Web: Making a File Versioned
- Web: Accessing a Previous Version of a File
- Web: Working With Multiple Versions of a File
- Introduction to Check In and Check Out
- Windows: Checking Out a File
- Windows: Checking In a File
- Web: Checking Out a File
- Web: Checking In a File
- Web: Canceling a Check Out
- Introduction to Locking
- Windows: Locking and Unlocking Files
- Web: Locking and Unlocking Files
Overview of Oracle iFS Content Management

Oracle iFS gives you the ability to manage your data in two significant ways:

- You can use the file versioning feature to save the current version and any subsequent versions, by checking versioned files in and out. When you check in a versioned file, Oracle iFS automatically creates a version history that lets you access previous iterations of the document. When the version history is created, you are given the option of including comments for yourself and others about the changes made and what prompted them.

- Or you can use the locking feature, to prevent anyone from making edits to your work. You can lock folders, as well as files that haven’t been versioned. When you lock a file or folder, no change history is created, since you aren’t allowing changes.

Locking is useful when you are the sole content manager of a folder and it’s ready to publish. By locking the folder, no further changes may be made to it.

Versioning also adds value when you are the sole author of your files, because it allows you to retain data that you might need again in the future. But it is especially useful when you are working collaboratively with other content contributors on one or more files.

Introduction to Versioning

Versioning allows you to retain the original and any subsequent copies of a file in the database, while you make revisions to the file on your local drive.

Versioned files must be checked in and out of the database. Checking out a file means that no one will be able to edit that file while you work on it. Checking the file in again frees it for editing by individuals with the appropriate permissions.

Whenever you check in a versioned file, Oracle iFS automatically keeps a copy of the older file as well as the new version, and, over time, builds a version history for the file. For example, if you check out a memo, change it, and save your changes, then decide that you made a mistake, you can retrieve the previous version, or an even older version, instead of trying to reconstruct it from memory.

Here is an example of a Version History:
Introduction to Versioning

Figure 5–1 Version History lists all versions of a file

<table>
<thead>
<tr>
<th>Select</th>
<th>Type</th>
<th>File Name</th>
<th>Status</th>
<th>Size</th>
<th>Comments</th>
<th>Date Modified</th>
</tr>
</thead>
<tbody>
<tr>
<td>☑</td>
<td>☑</td>
<td>startup.fm</td>
<td>X</td>
<td>194KB</td>
<td>prod 1.0 source file</td>
<td>August 11, 2000 10:29:49 AM PDT</td>
</tr>
<tr>
<td>☑</td>
<td>☑</td>
<td>startup.fm</td>
<td>X</td>
<td>194KB</td>
<td>wrong version</td>
<td>August 11, 2000 11:01:04 AM PDT</td>
</tr>
<tr>
<td>☑</td>
<td>☑</td>
<td>startup.fm</td>
<td>X</td>
<td>194KB</td>
<td></td>
<td>August 11, 2000 11:14:14 AM PDT</td>
</tr>
<tr>
<td>☑</td>
<td>☑</td>
<td>Startup.fm</td>
<td>X</td>
<td>5.37MB</td>
<td>correct version</td>
<td>August 11, 2000 3:32:16 PM PDT</td>
</tr>
<tr>
<td>☑</td>
<td>☑</td>
<td>Startup.fm</td>
<td>X</td>
<td>5.35MB</td>
<td>Franko's revisions</td>
<td>August 13, 2000 2:55:24 PM PDT</td>
</tr>
<tr>
<td>☑</td>
<td>☑</td>
<td>Startup.fm</td>
<td>X</td>
<td>5.35MB</td>
<td>Added info, final edit, sparkcheck</td>
<td>August 14, 2000 4:29:36 PM PDT</td>
</tr>
<tr>
<td>☑</td>
<td>☑</td>
<td>Startup.fm</td>
<td>X</td>
<td>5.35MB</td>
<td>Version 1.1 review copy</td>
<td>August 19, 2000 2:32:44 PM PDT</td>
</tr>
<tr>
<td>☑</td>
<td>☑</td>
<td>Startup.fm</td>
<td>X</td>
<td>5.35MB</td>
<td>added web folders test</td>
<td>August 21, 2000 9:11:49 AM PDT</td>
</tr>
<tr>
<td>☑</td>
<td>☑</td>
<td>startup.fm</td>
<td>X</td>
<td>5.39MB</td>
<td>added info, web folders, email, ftp</td>
<td>August 22, 2000 12:46:26 PM PDT</td>
</tr>
<tr>
<td>☑</td>
<td>☑</td>
<td>startup.fm</td>
<td>X</td>
<td>5.39MB</td>
<td>Revision comments</td>
<td>August 22, 2000 6:42:07 PM PDT</td>
</tr>
<tr>
<td>☑</td>
<td>☑</td>
<td>Startup.fm</td>
<td>X</td>
<td>5.39MB</td>
<td>revisions done</td>
<td>August 24, 2000 7:02:17 PM PDT</td>
</tr>
<tr>
<td>☑</td>
<td>☑</td>
<td>Startup.fm</td>
<td>X</td>
<td>5.16MB</td>
<td>Revisions made 9/24/00</td>
<td>August 24, 2000 7:02:16 PM PDT</td>
</tr>
</tbody>
</table>

The versions shown in the Version History may be viewed only; they cannot be changed. Users with appropriate permissions can download a previous version to their local drive and edit it. When the file is uploaded, it becomes the current version but cannot be edited until you check the file in again.

How Versioning Works

You make a file versioned using a single command ("Make File Versioned" on the Windows interface, "Make Versioned" on the Web interface). A versioned file is automatically given additional attributes that store information about the file family (all versions of the file) and each version of the file as it is created.

To protect the file from being overwritten, if you save a new copy of a versioned file, that act itself creates a new version of the file. If you check out the file and save new versions of the file, Oracle iFS stores the new copies but doesn’t create a new version until you check the file back in.

You can use the iFS Versions tab on the Properties window of the Windows interface, or the History command on the Edit menu of the Web interface, to view and access previous versions of the file. You can even restrict access to the older versions for a particular type of user. In this way, a published website may be an older version than the version the content developers are currently working on.

Because Oracle iFS adds special attributes to versioned files, to retain these attributes you must check the file out and copy it to your local drive to edit it. The
next time you check in the file (not necessarily the next time you save the file), a new version is created.

For example, if you were to check out a file, you could then edit the checked-out version. You could make several changes, saving after each one. When you were done editing, you could then check in the file. At that point, a new version would be created, and would be the version directly after the one you checked out. Alternatively, if you don’t check out the file, but make changes to it and save them, each time you save the file a new version is created.

An Example of Versioning
Let’s say you have written a report, a presentation, and a flowchart that must be reviewed by three people: a content editor, a subject matter expert, and the head of your department. Assume that all three people have the correct permissions to edit each file.

1. Upload the three files to Oracle iFS, following the directions in Chapter 3, "Managing Files and Folders".
2. Make all the files versioned, as described in the following sections.
3. Apply the appropriate ACL to the files. Refer to Chapter 6, "Managing Access to Files" for more information on ACLs. With the Web interface, you can apply the ACL as you upload.
4. Notify your three reviewers that the files are ready for review.

At this point your reviewers are able to check out each file and download it to a local drive to make their edits. If a file is already checked out by another reviewer, they will not be able to edit it until it is checked in again. This approach results in multiple versions of the file, each modified by a different reviewer.

How to Copy Versioned Files
Whenever you check out a versioned file, the best practice is to copy it to your local hard drive. In many cases, especially with Microsoft Office documents, it’s a good idea to work on a local copy of the file, then upload the final version. The reason for this is that some applications cause Oracle iFS metadata about the file to be lost, along with previous versions, when the file is saved.

- In Windows Explorer, you can copy a file by right-clicking the filename, then dragging and dropping the file into a local folder. When you drop the file, a menu will be displayed. Choose Copy Here, and the file will be copied.
If you are working with the Web interface, right-click the name of the file you want to save to your local drive. On the context menu, click Save as link and select the directory to which you want to save the file.

**Note:** To prevent others from editing the originals while you work with them, versioned files that you copy to your local drive for editing must be checked out before you copy them.

---

**Nonversioned vs. Versioned Files**

The first time you upload a file into Oracle iFS, the file is nonversioned. Whether that original is retained in the database as changes are made to it depends on whether it becomes a versioned file, or remains nonversioned. The following subsections explain what you can do with versioned versus nonversioned files.

**Nonversioned Files**
Here’s what you can do with a nonversioned file:

- **Delete the file** - Results in the file no longer being displayed in the folder, and removes it from the repository if there are no linked files.
- **Modify file content**: Updates the file’s content; results in overwriting the old content. No history is saved.
- **Change ACLs**: Allows the user to select a system ACL to associate with the file.
- **Lock the file**: Prevents anyone, including the system administrator, owner, or person who locked it, from deleting or modifying file attributes or content without first unlocking the file.
- **Unlock the file**: Cancels the lock, allowing deletion and modification of the file by users with appropriate permissions.
- **Rename the file**: Allows you to change the file name.
- **View file properties**: Allows you to see the file path, description, owner name, last modification date, expiration date, and other properties of the file.
- **Make the file versioned**: Results in a Family, VersionSeries, and VersionDescription being created for the file on background. The file is now available for check-out.
Versioned Files
The unique characteristic of a versioned file is that a version history is saved for it. You can access the history of changes, and view older versions, although older versions are available as read-only files. Only the most recent version is editable. Here’s what you can do with a versioned file:

- **View the history**: Provides a list of the file’s versions; neither the content nor the attributes of older versions can be modified.

- **Delete the file from the File List**: Results in the file no longer showing up in the folder, and removes all versions from the repository if there are no linked files. You can also delete previous versions using the Version History list. However, you cannot delete the most current version from the Version History list.

- **Delete a specific file version**: Removes that specific version of the file from the history. The version numbers are not collapsed when a specific version is deleted.

- **Link a specific file version**: You can create a link from a specific version to a different folder than the one containing the current version. For example, you might store the current version in your Work In Progress folder, and store an earlier version in the Published folder.

- **Rename the file** (Web interface only): Allows you to change the file name.

- **View file properties**: Allows you to see the file path, description, owner name, last modification date, expiration date, and other properties of the file.

- **Modify file attributes**: Allows you to change certain file attributes; does not create a new version.

- **Change ACLs**: Allows you to select a system ACL to associate with the file.

- **Lock a specific file version**: Prevents anyone, including the system administrator, owner, or person who locked it, from deleting or modifying the attributes or content of a specific version without first unlocking the file.

- **Unlock a specific file version**: Cancels the lock, allowing deletion and modification of the version by users with appropriate permissions.

- **Check out the versioned file**: Reserves the file for modification only by the person who checked out the file.

- **Modify the content of a checked-out file**: Permits the person who checked out the file to delete or modify the most current version’s attributes or content.
Windows: Making a File Versioned

- **Cancel the check-out (Web interface only):** Allows the person who checked out the file to cancel the check-out. No new version is created; the file is freed for deletion, modification, or check-out by anyone with appropriate permissions.

- **Check the file in:** Creates a new version with the edited content; allows the person who checked out the file to add a check-in comment.

---

**Note:** Changing a versioned file’s content and checking it back in will always result in a new version.

---

Windows: Making a File Versioned

All file versions can be viewed and managed from the iFS Versions tab of the Windows Properties window. To make a file versioned:

1. Right-click the desired file. If you want to version multiple files, hold down the Ctrl key and select the files, then right-click.

2. Choose Make File Versioned.
3. Since this is the first version of the file, you may type a comment to associate with all the files you selected for versioning.

A confirmation message is displayed.

4. Click OK to version the file, or Cancel to abort versioning.

**Windows: Viewing a File’s Version History**

To view the version information for a file in the Windows interface:

1. Right-click the file whose version information you want to view.

2. From the bottom of the context menu, choose Properties.

3. In the Properties window, select the iFS Versions tab.
The iFS Versions tab is broken into three sections, described in the table below.

**Table 5-1 iFS Versions tab**

<table>
<thead>
<tr>
<th>Section</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Primary Version</td>
<td>Lists all available versions of the file by number.</td>
</tr>
<tr>
<td>Series</td>
<td></td>
</tr>
<tr>
<td>File Information</td>
<td>Lists the file name, the date it was created, the date it was last updated, and an optional comment about that version.</td>
</tr>
<tr>
<td>Other Version</td>
<td>Lists properties specific to this particular file such as Version label, and properties applicable to its Version Family. These are related to the regular attributes described in Chapter 3.</td>
</tr>
<tr>
<td>Attributes</td>
<td></td>
</tr>
</tbody>
</table>

**Windows: Accessing a Previous Version of a File**

To access a specific version of a file, other than the most current version, you must make a copy of the version you want to work with:

1. Right-click on the file in Oracle iFS, and choose Properties from the context menu.
2. In the Properties window, select the Versions tab.
3. Select the version you want to copy.
4. Click the Copy to... button.
5. Navigate to the folder location where you want the copy to be placed.
6. Click OK.

The version you selected is now copied to the chosen location. You can rename the file, modify it, and either replace the current version or maintain it as a separate file.

**Windows: Removing Versions**

To remove one or more versions of a file from the database:

1. Right-click on the file(s) in Oracle iFS, and choose Properties from the context menu.
2. In the Properties window, select the iFS Versions tab.
3. Select the version(s) you want to remove.
4. Click the Remove button.
5. Click OK.

Only versions prior to the latest version can be deleted. You cannot delete all versions. One must remain after your delete.

Web: Making a File Versioned

To make a file versioned:

1. In the File List, click the Select checkbox to the left of the file you want to make a versioned file. You can select more than one file at one time. To select all the files, click the Edit icon and choose Select All.
2. Click the Check In/Out icon and choose Make Versioned.
You can tell a file has been versioned, because the file name is displayed in the File List in **boldface** type. Oracle iFS handles the versioning tasks for you automatically.

**Web: Accessing a Previous Version of a File**

To access a previous version of a file, use the History function:

1. In the File List, click the Select checkbox to the left of the file for which you want to view the version history. You must select a versioned file – i.e., a file name that is in bold face type.

2. Click the Edit icon and choose History. The File List displays all of the versions of the file currently stored in the Oracle iFS repository, along with a status icon, the file size, any comments about the version, and the date each version was last modified.

   In the Status column, you may notice a pencil with a red line through it, denoting that the history files are read-only.
3. Click the file name or Type icon of any version to open it and review its contents.

**Note:** If you want to edit the earlier version, click the Select checkbox to the left of the file you want to edit. Click the Edit icon, and select Copy from the drop-down menu. Paste the file to a local directory.

By editing an earlier version and uploading it to a directory where the file currently appears, you can make an earlier version the latest version. This involves deliberately overwriting the current version with a previous version. No data is lost; what was the current version is saved. For information on uploading files to Oracle iFS, see Chapter 3, "Managing Files and Folders".
Web: Working With Multiple Versions of a File

On the History Of... Web page, there is a Select checkbox beside each version that allows you, if you have the appropriate permissions, to perform the following functions with a given version.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Functions Available</th>
</tr>
</thead>
<tbody>
<tr>
<td>Edit</td>
<td>Cut, Copy, Select All, Rename, Properties, Parents, Apply ACLs to the selected version(s).</td>
</tr>
<tr>
<td>Delete</td>
<td>Delete the original version and/or a subsequent version or versions. You cannot, however, delete all versions. The most current version must remain in the database.</td>
</tr>
</tbody>
</table>

Introduction to Check In and Check Out

The Check In/Check Out feature lets you collaborate with others working on the same files, while making sure that no one inadvertently writes over a file that you are working on.

In order to use the Check In/Check Out feature, the file must be a versioned file.

Checking in or checking out a file is similar to locking and unlocking a file, except that a new version of the file is created whenever the file is checked in. This preserves a version history of the file. Locked files are similarly protected, but cannot be modified until they are unlocked, and do not preserve a version history. Any saved changes in a locked file overwrite the previous (and only) version of the file. For more information, see “Overview of Oracle iFS Content Management”.

How Does Check In/Check Out Work?

When several people have access to the same files at the same time, two users may try to change and save the same file at the same time. Here is what may happen if you don’t use a check in/check out system:

10:00 a.m. Aneli opens the file and begins to make changes.
To avoid this problem, the Check in/Check out function prevents other users from saving changes to a file that is already checked out. When you know you are working collaboratively and want to protect the changes you make from being inadvertently overwritten, you can protect your work by following the check in/check out process:

- Be sure the file is versioned.
- Check out the file before you make any changes to it.
- Copy the file to a local drive.
- Make your changes.
- Save the file.
- Copy the file back to the appropriate Oracle iFS folder.
- Check in the file so that others can read and work with it.
- (Optional) Add a comment describing the changes you made.

What Happens When a File Is Checked Out?

When a file is checked out, the person who has the file checked out is allowed the permissions granted to their ACE. Other users see a lock icon in the file Status column on the Web interface, and have read permission only. They will not see the new version of the file until it is checked in.

- They can view the original file and make copies of it to their local drive. The copy can then be renamed, edited, saved, e-mailed to others, and otherwise treated as a normal file.
- They are not allowed to change the original file in iFS, save it, rename it, or change the properties of that file until it is checked in.

What Happens When a File Is Checked In?

After changes to a file have been made and the file has been saved, the person who checked out the file checks it back in. Once the file is checked in:
Other users can see the new version.

Other users can check out the file from the database.

Other users can make changes to the text, save the file, rename the file, and change the attributes of that file.

Of course, this list assumes that the other users have the required security privileges to access the file.

**Windows: Checking Out a File**

To check out a file:

1. Right-click the file to check it out. If you want to check out multiple files simultaneously, select all of the files, then right-click the selected files. You cannot check out locked files or nonversioned files.

2. From the context menu, select iFS Check Out.
   The system displays a confirmation message.

3. Click OK to acknowledge the message.

---

**Note:** In the Windows interface, there is no visual cue, other than the confirmation message, to tell you the file is checked out. To avoid confusion, the best practice is to make a copy of the checked-out file to your local drive, edit and save it there, then paste it back to its original Oracle iFS folder before checking it in again.

**Windows: Checking In a File**

Checking in a file creates a new version of the file. If you plan to make incremental changes to a file and want to keep each version, then you must check the file out and back in each time you make changes to it. Otherwise, if you just keep updating the file, only the version you check in is kept. Alternatively, if you don’t check out the file, each time you update it, a new version is automatically created. You do, however, run the risk that someone else will work on the same file you are working on and overwrite your work.

To check in a file:
Web: Checking Out a File

1. In Windows Explorer, drag a revised version of the file into the file’s Oracle iFS folder to update the checked-out version.

2. Right-click the file to check it in. If you want to check in multiple files simultaneously, select all of the files, then right-click them.

3. From the context menu, select iFS Check In.

4. In the optional Revision Comment field, enter a comment describing the changes you’ve made, and click the OK button. The system displays a confirmation dialog box.

5. Click OK to complete the check-in.

---

Note: If you decide that you don’t want to update a file you’ve checked out, there is no command in the Windows interface that lets you cancel the check-out. Use the Web interface to cancel the check-out, which releases the file to other users without creating a new version.

Web: Checking Out a File

To check out a file using the Web interface:

1. Click the Select checkbox(es) to the left of the file(s) you want to check out. You can select more than one file at a time. To check out all the files, choose Select All from the Edit menu.

2. Click the Check In/Out icon, and choose Check-out.

You now have full read/write access to the file, if you have the appropriate permissions. Other users have read-only access to what was the latest version until you check in the file.

Web: Checking In a File

To check in a file or files using the Web interface.

1. Upload the changed file(s) to the File List from which you checked it out. For information on uploading files, see Chapter 3, "Managing Files and Folders".
2. Click the Select checkbox(es) to the left of the file(s) you want to check in. You can select more than one file at a time and check in all of the files at once. If you do, the revision comment you enter will apply to all of the files.

3. Click the Check In/Out icon and choose Check-in.

4. Type any check-in comments and click OK.

Other users now have full read/write access to the file, if they have the proper permissions.

Web: Canceling a Check Out

If you have checked out a file, but decide not to check in changes, you can cancel the check out rather than checking in the file. This releases the file to other users without creating a new version of the file.

To cancel a check out using the Web interface:

1. Click the Select checkbox(es) to the left of the file(s) for which you want to cancel the check out.

2. Click the Check In/Out icon and choose Cancel Check-out.

When you cancel the check out, the file reverts to the version at check out. If you have made changes to the checked-out file, and want to save those changes, copy the file to another location before cancelling the check out.

Introduction to Locking

If your files are not versioned, you can prevent them from being overwritten by using the Oracle iFS locking feature. Both files and folders can be locked and unlocked. Locking is useful when you want to retain a file in the database, but don’t want to allow changes to it, and, therefore, don’t require a change history.

Locking a file or folder prevents it from being deleted, moved, or modified until the person who locked the file unlocks it. When a file or folder is locked, no one, including the person who locked it, can accidentally change or delete it. The person who locked the file can open it and edit it, but those edits will not be saved.

Locking overrides the write and delete permissions of users other than the individual who locked the file. Those users can still open the file and download it to their own directories, if they have the appropriate permissions. However, the only person who can unlock it is the person who locked it.
You cannot delete a locked file or folder. If you attempt to delete an unlocked folder that has one or more locked files in it, you will not be allowed to do so.

Note: You cannot lock versioned files. Versioned files are protected automatically by the check-in/check-out process.

Windows: Locking and Unlocking Files

You can lock and unlock files and folders in the Windows interface by setting their Read-only property.

To lock files or folders:

1. Right-click the file(s) or folder(s) you want to lock and choose Oracle iFS Lock from the context menu. If you want to lock multiple files, select the files, then right-click the selected files and choose Oracle iFS Lock from the context menu.

2. Click OK to save your change.

You can verify that your file has been locked by right-clicking the file name and choosing Properties from the context menu. On the General tab, the Read-only checkbox will be checked. Or, you can look at the iFS Attributes tab. The LockState indicator will be set to "1."

To unlock files or folders, reverse the process:

1. Right-click the file(s) or folder(s) you want to unlock and choose Oracle iFS Unlock from the context menu.

2. Click OK to save your change.

Again, you can verify that the lock has been removed by looking at the Read-only checkbox on the General tab or the LockState indicator on the iFS Attributes tab of the Properties menu.
Web: Locking and Unlocking Files

To lock a file or folder:

1. Click the Select checkbox to the left of the file you want to lock.
2. Click the Check In/Out icon and choose Lock.

A lock icon appears in the Status column of the file(s) you locked.

**Figure 5–5  The Lock icon**

<table>
<thead>
<tr>
<th>Select</th>
<th>Type</th>
<th>File Name</th>
<th>Status</th>
<th>Size</th>
<th>Date Modified</th>
</tr>
</thead>
<tbody>
<tr>
<td>☐</td>
<td></td>
<td>August release</td>
<td></td>
<td>19KB</td>
<td>29-Aug-00 3:01:41 PM</td>
</tr>
<tr>
<td>☐</td>
<td></td>
<td>Change List</td>
<td></td>
<td>22.5KB</td>
<td>29-Aug-00 3:05:24 PM</td>
</tr>
<tr>
<td>☐</td>
<td></td>
<td>ch1.1.htm</td>
<td></td>
<td>472KB</td>
<td>29-Aug-00 3:48:37 PM</td>
</tr>
<tr>
<td>☐</td>
<td></td>
<td>stats.doc</td>
<td></td>
<td>18KB</td>
<td>29-Aug-00 3:48:38 PM</td>
</tr>
</tbody>
</table>

When the lock icon has a key in it, as in the example above, you are authorized to unlock the file and work with it. When there is no key in the lock, you cannot unlock the file.

To unlock file(s) or folder(s):

1. Click the Select checkbox to the left of the file(s) or folder(s) you want to unlock. Before you can unlock a file or folder, a lock icon with a key should appear in the Status column for that object.
2. Click the Check In/Out icon and choose Unlock.

The lock icon will be removed from the Status column, and the file or folder can now be opened.
Managing Access to Files

This chapter covers ways to control who can use your files. Topics include:

- Security in Oracle iFS
- ACLs and ACEs
- Introduction to Permissions
- Types of ACL
- The System Administrator’s Role
- Windows: Changing Your Password
- Web: Changing Your Password
- Windows: Assigning a Default ACL to a File
- Windows: Creating an ACL
- Windows: Deleting Users or Groups from an ACL
- Web: Applying an Existing ACL
- Web: Creating a Custom ACL
- Working with Groups
- Managing Access to Folders
Security in Oracle iFS

Controlling access to data files and folders is a critical aspect of data management. Oracle iFS provides security at two levels:

- At the account level, Oracle iFS checks passwords to verify that a user is entitled to access.

- At the content level, Oracle iFS provides access control by matching a user or user group’s permissions with the permissions required to access a file or folder.

Whenever you create a new user or user group, you assign permissions, or levels of access, to the user or the members of the group. When you create a file or folder, you, as the owner of the file or folder, indicate which permissions a user or group must have in order to access that file or folder. If a user group has a lesser permission than is required to access a file, members of the group can’t open the file.

ACLs and ACEs

In Oracle iFS, user groups and individual users, along with the permissions assigned to them, are called Access Control Entries (ACEs). An ACE is one item in an Access Control List (ACL) that grants or revokes privileges to a user or group. Here’s what an ACL looks like from the Windows interface:
As you can see from this list, an ACL consists of:

- **A grantee**—A grantee can be a specific Oracle iFS user or a group. Groups are used in ACEs so that instead of assigning access to files or folders one user at a time, you can create a group, add users to it, then assign a set of permissions to the whole group at once. As a user, you could be listed on an ACL as an individual, but, in most cases, you would be included on an ACL as a member of a group.

- **A set of permissions**—Each permission groups a number of actions, definable by the system administrator. These actions might include Delete, Modify, Protected, and Read. When you create an ACL, you’ll indicate whether
permissions are Granted or Revoked. The permissions granted or revoked may be different for each ACE (user or group) in the list.

Granting Access to Files and Folders

As the owner of any folders or files you create, you can control who can access them and the level of access permitted. You can assign the predefined ACLs that are built into Oracle iFS or tailor one or more ACLs to fit your publishing strategy. Also, you can apply an ACL at two different levels:

- To a specific file
- To a folder

When an ACL is applied to a file or folder, it defines what individual users and groups are allowed to do with it. For example, when the Public ACL is applied to a file, it means that all users and groups have full access to that file.

When an ACL is applied to a folder, it defines what folder-level operations individual users and groups are allowed to perform with the folder (add files, remove files, etc.).

---

Note: The ACL of a folder does not apply to files within the folder. It is possible, for example, for a folder to have an ACL of Published, but for files within in to be Private, Public, Protected, or a user-defined ACL. The ACL applied to the folder may also be more restrictive than those applied to the folders and files in it. Access to the content of the folder is determined by the ACL associated with the files and folders within a folder.

---

As a user, you are assigned a default ACL that was determined by your system administrator. When you create a file or folder, your default ACL is applied to that item. In many cases, your default ACL will be Private, meaning that only you have access to that file or folder. To change your default ACL, you must have administrative permission. If you have any questions on this subject, you should contact your system administrator.
Introduction to Permissions

For each user or group, you need to decide which of five permissions will be granted to it. Permissions are actions that users are allowed to perform in relation to a file or folder. A set of permissions assigned to a specific user or group is called an Access Control Entry (ACE).

An Access Control List (ACL) is a list of ACEs that defines the level of access all of the listed users and groups will have to the files and folders to which you assign the ACL. ACLs give you the flexibility to grant the permissions your co-workers require, while helping to protect your files against accidental modification or unauthorized access.

The permissions you may grant and revoke for each ACE are listed and defined in the table below.

**Table 6–1  Access Permissions**

<table>
<thead>
<tr>
<th>Permission</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>All</td>
<td>Grants or revokes all permissions to members of this ACE.</td>
</tr>
<tr>
<td>Delete</td>
<td>Allows members of the ACE to delete or undelete an object. If a folder is governed by this permission, and no ACE exists for individual files, all files within the folder can be deleted by members of this ACE. Delete permission is also required to set the ExpirationDate attribute on public objects.</td>
</tr>
<tr>
<td>Modify</td>
<td>Allows members of the ACE to modify the file or the contents of the folder.</td>
</tr>
<tr>
<td>Protected</td>
<td>Protects folders from modification. It allows a user to add or remove files from within the folder, but, at the same time, it prevents the user from renaming or deleting the folder itself. This permission is used to define the default Protected ACL.</td>
</tr>
<tr>
<td>Read</td>
<td>Allows members of the ACE to read the file or the contents of the folder.</td>
</tr>
</tbody>
</table>

By setting each of these permissions for an individual or group, you create an ACE in your Access Control List. It’s possible to create a different ACE for every user in your Oracle iFS repository for every file you control, but, in most cases, the standard ACLs that come with Oracle iFS should meet your needs, and the remaining cases can be handled by creating a short ACL.
When you define an ACE, the first choice you must make is whether you are going to grant permissions to the ACE, or revoke them. If you are going to give only a few permissions to a selected user or group, choose Grant, and select only those few permissions.

If you are going to give the selected user or group general access with only a few restrictions, choose Revoke and select the permissions you don’t want the ACE to have. Users will receive all of the permissions except for the ones you revoked.

For example, if you want a group to have access to make changes to files in a directory, but not to delete the files, you would choose Revoke, then select the Delete permission. Users in the group would have complete access to the directory, but they couldn’t delete any files. Conversely, the standard Published ACL only grants Discover and Get Content privileges to users.

**ACE Precedence**

Access Control Entries are listed in a specific order in the ACL, usually the order in which you create them. An ACE that’s lower in the list supersedes all the ACEs above it.

For example, I can create an ACL named scottACL.

The first Access Control Entry I create is for the group scotts_group. I give scotts_group no permissions at all. If I apply the Access Control List to a folder at this time, no one, including Scott, will have access to the folder.

Scott is the manager of scotts_group. He needs to have full access to the folder. I create an ACE for the User scott. In the Access Control Entry for scott, I grant All permissions. Since scott’s ACE appears at the bottom of the Access Control List, his ACE supersedes the instructions in the scotts_group ACE.
The final result is that Scott has full access to the folder. No one else in Scott’s group can view or modify anything in the folder.

It’s important to keep the ACE precedence in mind as you create your ACL in order to implement the security settings you want. In this case, if I created the ACE for scott before I created the ACE for scotts_group, no one, including Scott, could access a folder or file assigned that ACL.

Types of ACL

There are two categories of ACL:

- Predefined ACLs, packaged with iFS, which provide basic security.
- User-defined ACLs, defined by individual users for special circumstances not covered by the predefined ACLs.

**Predefined ACLs**

Predefined ACLs provide the following security levels:

<table>
<thead>
<tr>
<th>ACL</th>
<th>Description</th>
<th>Compatible Permissions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Private</td>
<td>This is the default ACL applied to all files and folders you create. It grants no permissions to any other user other than the owner and users with administrative privileges. Other users can’t see or modify your file in any way.</td>
<td>You and users with administrative privileges are granted all permissions. All permissions are revoked for other users.</td>
</tr>
<tr>
<td>Protected</td>
<td>This ACL is applied to folders or files. It enables other users to see the files in the folder, add files and folders to the folder, and remove files and folders they have created from the folder. The grantee cannot delete the folder or change its properties.</td>
<td>Protected</td>
</tr>
<tr>
<td>Public</td>
<td>This ACL is applied to folders or files. It allows full access to the item. Users can make any changes to the directory that the owner can make.</td>
<td>All (Read, Modify, Delete)</td>
</tr>
<tr>
<td>Published</td>
<td>This ACL is applied to folders or files. It allows other users to see the item and its contents.</td>
<td>Read</td>
</tr>
</tbody>
</table>

**User-defined ACLs**

You can create a user-defined ACL to cover any specific security needs not provided by the predefined ACLs. For example, a marketing manager might decide that everyone in the marketing department needed access to all product collateral currently being developed. The manager could create a custom ACL to provide that access by performing the following steps:

1. Create a group called "Marketing."
2. Add each user in the marketing department to that group.
3. Create an ACL called "Collateral" that allows its members to have read access, but not write access or delete access.
4. Add the marketing group as an ACE to the Collateral ACL.
5. Assign the Collateral ACL to the directories containing data sheets and white papers about the product.

In this case, every member of the marketing group would have the same access to the files in the Collateral directory. Unspecified users (users for whom no ACE was created either granting or denying permission) would have whatever the default ACL for the creating user was.

The System Administrator’s Role

Before you can begin managing access to your files, your system administrator must perform certain tasks related to Oracle iFS security:

- Create new users.
- Set up passwords for new users.
- Provide new passwords for current users when passwords are lost.
- Arrange users into groups and then grant permissions to those groups.

What You Can Do

Once the system administrator has created an initial set of users and groups, you can do the following:

- Change your existing password using either the Windows interface or the Web interface.
- Create ACLs.
- Create and manage groups.

The remainder of this chapter will deal with your security tasks.
To change your password, access your user profile:

1. In Windows Explorer, right-click the mapped drive.
2. On the context menu, click iFS User Profile...

Figure 6–3  The context menu displays available Oracle iFS utilities

3. In the Password text box of the dialog that is displayed next, type your old password.
4. In the New Password field, type the new password.
Figure 6–4 The User Profile window allows you to change passwords

5. In the Confirm Password text box type the new password again.
6. Click OK. Oracle iFS confirms that the password has been changed.

To change your password:

1. At the top of the Directory Tree, double-click your login name or the User icon.
2. On the User screen, type your new password in the Password field.
Figure 6–6  Change your password on the User window of the Web interface

3. Type your new password again in the Confirm Password field.
4. Click OK.

Windows: Assigning a Default ACL to a File

You can assign any of the default ACLs to a folder or file you control.

To assign an ACL to a file or folder:

1. Right-click the file or folder to which you want to assign an ACL.
2. From the context menu, choose Properties.
3. In the Properties window, click the iFS Security tab.

Figure 6–7 The iFS Security tab shows the current ACL

The iFS Security tab displays the name of the ACL currently assigned to the item you selected with the Grantees and their abbreviated access levels. For example, in the illustration above, the Published ACL grants Read privileges to the World, a group that represents all users in the Oracle iFS repository.
4. Click the Use Existing Access Control List button.

**Figure 6–8 Choose an ACL from the Access Control List box**

5. Select the ACL you want to use from the Access Control Lists box. When you select an ACL, its description appears in the box below the list of ACLs, along with abbreviations for the access levels granted by the ACL.

6. Click Use ACL.

7. In the Properties dialog, click OK to assign the ACL.

When assigning ACLs, you must ensure that the folder enclosing the file or folder allows sufficient access to your users that they can discover (view and select) the items to which you’re granting them access. For example, if you grant full access privileges to a file that is stored in a folder that uses the Private ACL, users will be unable to locate the file because even though they have been granted permission to view and edit the file, they don’t have permission to look inside the folder where it’s kept.
Windows: Creating an ACL

To create an ACL:

1. Right-click the file to which you want to assign the new ACL.
2. Select Properties from the context menu.
3. Click the Oracle iFS Security tab.
4. If the ACL you want to create is similar to an existing ACL, click Use Existing ACL and select the ACL on which you’ll base your new ACL. Otherwise, continue with Step 7.
5. Enter a name for your new ACL in the Access Control List Name field.
6. If necessary, select any unwanted Grantees in the ACE list and click Remove.
7. Click New Entry.

Figure 6–9 Create Access Control Entry screen
8. In the Add Oracle iFS Access Control Entry dialog, click the Browse button.

**Figure 6–10  Select Users and Groups screen**

9. Select a group or user for this ACE and click OK.

10. Click the check boxes to set the permissions you want to grant in the ACE.

11. Click OK to create the ACE.

12. Repeat steps 7-11 to create any additional ACEs for this ACL.

13. Click OK to save the ACL.
Once you’ve created your ACL, you can assign it to a file or folder as described in the “Windows: Assigning a Default ACL to a File” section.

When you create an ACE, rather than defining the permissions you’re granting to users, you can define the permissions you’re revoking. If you’re primarily granting full access but revoking one or two permissions, it may be easier to define just the actions the user can’t take. To define an ACE that revokes privileges, click the Revoke Control Entry checkbox at the bottom of the Add Oracle iFS Access Control Entry dialog.

Windows: Deleting Users or Groups from an ACL

The Remove button lets you delete a selected ACE from an ACL. This can either provide more or less access for the users, depending on the definition of the ACE.

To remove an ACE from an ACL:

1. Right-click a file in an iFS folder.
2. Choose Properties.
3. Click the iFS Security tab.
4. Click the Use Existing ACL button.
5. From the Use an Existing ACL dialog, select the ACL you want to change and click Use ACL. The ACL is displayed in the iFS Security tab.
6. Select the ACE you want to remove.
7. Click Remove.
8. Click OK to store your changes.

There is no way to edit an existing ACE within the Windows interface. To change an ACE, remove the existing entry, as described in this topic, then recreate the ACE with the new permissions. You can, however, change the order of ACEs within an ACL. Select an ACE and click on the Move Up and Move Down buttons to reorder your ACL. For more information on ordering ACEs within an ACL and how this affects access, see “ACE Precedence”.
Web: Creating a Custom ACL

To create an ACL in the Web interface:
1. Click ACLs in the Directory Tree.
2. Click the New icon and choose ACL.
3. In the dialog, enter a name for the ACL and click OK. The ACL is added to the ACL list.
4. Click the icon or ACL name you just created. The Edit ACL window is displayed.
5. Select the Users or Groups for whom you want to create ACEs.

Web: Applying an Existing ACL

To apply a standard ACL to a file or folder:
1. Navigate to the parent folder of the item to which you want to apply the ACL.
2. Click the Select checkbox to the left of the file or folder to which you want to assign the ACL. You can select more than one item at a time.
3. Click Edit and choose Apply ACL. A dialog appears with a list of defined ACLs.
4. Select the ACL you want to apply to the selected file(s) or folder(s).
5. Click OK. A success message appears to tell you that the ACL has been applied to the items.
6. Click OK.
6. Click Add Access Control Entries.

7. Each of the users or groups you selected has a separate ACE. For each, choose whether the ACE will Grant the privileges you select or Revoke the privileges you select. Scroll right to see all of the available permissions.
Web: Creating a Custom ACL

Managing Access to Files 6-21

Figure 6–12  Grant or Revoke privileges for users

<table>
<thead>
<tr>
<th>Access Control Entry</th>
<th>GRANT</th>
<th>REVOKE</th>
<th>All</th>
<th>Class</th>
<th>Public</th>
<th>Class</th>
<th>Restrict</th>
<th>Creation</th>
<th>Delete</th>
<th>Modify</th>
<th>Protected</th>
<th>Read</th>
</tr>
</thead>
<tbody>
<tr>
<td>scott_group (admin)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>scott</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

8. Set the permissions by selecting the corresponding checkbox.

9. When you have selected all of the permissions for each of the ACEs, arrange the ACEs in the correct order of precedence. Click the Up arrow at the left edge of the ACE to move it up in the list. Click the Down arrow to move the ACE down. The lowest ACEs in the ACL always take precedence over those ACEs listed above. If a user’s permission is revoked in the first ACE but granted in the second ACE, that user will be granted the permission.

10. When you have set all of the permissions and arranged the ACEs in order of precedence, click the Apply Permission Changes button.

The ACL you have created can now be applied to any of the files or folders you control as described in the section Applying an Existing ACL.

Advantages of the Web Interface for Creating ACLs

The ACL editor in the Web interface has two advantages over the Windows ACL editor.

- **ACEs are editable**—The Windows interface does not enable you to open an existing Access Control Entry and change its settings. To change an ACE in the Windows interface you have to delete the entry, then recreate it. In the web interface, you can open the ACLs folder, click on an ACL, then make any changes you like to the permissions in the individual ACEs.

- **ACEs can be rearranged**—If you accidentally list your ACEs in the wrong order, you can use the Up and Down arrows at the far left of each ACE to move the entry up or down in the list. The lowest items always take precedence over the higher items.
Working with Groups

Groups are logical collections of users, usually organized by job function or project. By creating a group, you can assign the same permissions to several users at once.

Web: Creating a Group

To create a user group in the Web interface:

1. In the Directory Tree, click the Groups icon. (If there is no Groups icon, see your system administrator.) A list of existing user groups will be displayed at the right.

   Figure 6–13  The Group list

2. Click the New icon and choose Group.
3. In the New Group dialog, enter a name for the group. When you click OK in the dialog,
4. Click the Users icon.
5. In the Users List, click the Select checkbox to the left of each user you want to add to your group.
6. Click the Edit icon and choose Copy.
7. In the Directory Tree, click the Groups icon.
8. Click the name of the group you just created.
9. Click the Edit icon and choose Paste.

You can add users to the group at any time by following steps 4-9.

Adding Individuals and Groups to Groups
If you have already defined groups, you can add a user or group to a group.

To add a group to a group:
1. Click the Groups icon.
2. In the Groups List, click the Select checkbox to the left of each group you want to add to your group.
3. Click the Edit icon and choose Copy.
4. Click the name of the group to which you want to add the second group.
5. Click the Edit icon and choose Paste.

You can also add individuals to groups, following the steps listed above. Instead of copying and pasting a group name, you’ll select an individual from the Users icon, and copy and paste that individual’s name into your group list.

Editing Groups
To edit a group, click the Groups icon in the Directory Tree, then click the group’s name in the Groups List. Follow the steps for adding and removing users and groups.

To remove a Group, click the Select checkbox to the left of the Group name, then click the Delete icon.
Assigning ACLs to Groups

To ensure that the group can access the content they need, and only that content, you must assign an ACL to each group you create.

1. From the Directory Tree, select the Groups icon. A list of groups will be displayed to the right.

2. Select the group or groups to which you want to assign the ACL. If you select more than one group, all groups will have the same ACL.

3. Click the Edit icon and select Apply ACL. A list of all existing ACLs will be displayed. The ACL currently applied to your group will be selected.

4. Select the ACL you want to apply to your group.

5. Click OK.
Managing Access to Folders

Earlier, we noted that the ACL applied to a folder does not automatically apply to every file or folder in the folder. This grants you a great deal of flexibility in organizing your data and granting access. It allows you to, for example, place all Human Resources material in one folder or hierarchy of folders, but grant less access to certain files than to others.

Here’s one scenario:

I create a folder called "Marketing Department," which has my default ACL of Private. However, I change the default to Published. I use Published, because I want others to be able to view the contents and download them, but not change them. (I could use Protected, but that would allow others to add files and folders to this folder, and in this case, I don’t choose to allow them to do so.)

In the folder, I place a Word template (.dot) to be used for weekly reports by my staff. This template requires that users have the Published permission, so they can see and download it, but not change it or delete it from the folder.

I add an Excel spreadsheet (.xls) on monthly sales figures, but want to limit access to this data. So I apply a custom ACL, Marketing Managers, to it. Applying this ACL gives Marketing Managers full access to the data, but revokes all access for anyone else.

Finally, I add my own notes on prospective clients, which I don’t want anyone but myself to read, and which has the ACL Private. No one else can see, modify, delete, or download this file.

Now, I have all my marketing data in one place, but access to specific content is granted or revoked based on the user groups’ need to use it.

For more on managing access to data in folders, please refer to Chapter 3, "Managing Files and Folders".
A
access
  anonymous, 2-22
  e-mail, 2-22
access control lists (ACLs)
  advantages to creating with the web, 6-21
  creating and using, 6-16
  creating and using with the web, 6-19
  custom creation using the web, 6-19
  deleting users and groups from, 6-18
  overview, 6-4
ACE
  definition of, 6-5
  permission list, 6-5
  precedence, 6-6
    changing, 6-18
ACL
  and folders, 6-4
  and new groups, 6-24
  applying during upload, 3-12
  changing user default, 6-4
  creating, 6-16
  custom, 6-8
  definition of, 6-5
  grantee, 6-3
  predefined, 6-8
  set of permissions, 6-3
  types, 6-7
  user default, 6-4

B
Boolean operators, 4-23

C
character set
  and binary files, 3-12
  and text-based files, 3-12
  assigning (Web), 3-12
  reasons for using, 3-13
  check in
    using with the web, 5-16
  check in/check out
    compared to locking, 5-13
    file requirements, 5-13
    how it works, 5-13
    introduction, 5-13
    value of, 5-13, 5-14
    what happens when a file is checked in, 5-14
    what happens when a file is checked out, 5-14
  check out
    canceling (Web), 5-17
    using with the web, 5-16, 5-17
    windows, 5-15
  client
    configuring, 2-21

D
description, 4-8
directory
  structure, 2-2
Directory Tree
  and editing groups, 6-23
document
  parents, 3-18

E
e-mail
  access, 2-22
  configuring for ifs, 2-25
  using ifs server for access, 2-26
  expiration date, 4-9
file
  attributes, 3-23
    custom, 3-23
  changing attributes, 3-26
  copying using the web, 3-15
  deleting using the web, 3-16
  description, searching for, 4-8
  expiration date, 4-9
  finding, 4-2
  finding using the web, 4-15
  finding using windows, 4-5
  locking with the web, 5-19
  locking with windows, 5-18
  moving using the web, 3-16
  opening using the web, 3-9
  renaming using the web, 3-9
  uploading using the web, 3-16
  using the file attributes tab, 3-25
  versioning using windows, 5-7
  viewing attributes using windows, 3-23
  viewing parent folders using windows, 3-19
  working with in windows, 3-7
  working with the web, 3-9

find
  advanced criteria, 4-11
  executing using windows, 4-14
  specifying content criteria, 4-13
  using the web, 4-15

folder
  closing in the web, 3-8
  copying using the web, 3-8
  creating using the web, 3-8
  deleting using the web, 3-9
  home folder, 3-3
  in windows, 3-5
  mail, 3-4
  moving using the web, 3-9
  navigating using the web, 2-17
  opening in the web, 3-7
  renaming using the web, 3-8
  using default, 3-2
  viewing parents using windows, 3-19
  working with the web, 3-7

folder hierarchy
  definition, 3-2
  uses for, 3-2

folders
  accessing, 3-4
  default, 3-2
  home, 2-2, 3-2, 3-3
  inbox, 2-2, 3-2, 3-4
  mail, 1-5, 2-2, 3-2
  public, 2-2, 3-2
  root, 3-2
  viewing parents, 3-21

FTP, 1-7
  and check-in/check-out, 2-21
  and file uploading, 3-13
  and Oracle iFS, 2-21
  uses for in Oracle iFS, 2-21

ftp
  access, 2-21
  anonymous access, 2-22
  anonymous ftp access, 2-21
  commands not supported, 2-22
  configuring, 2-21

groups
  deleting from an ACL, 6-18

ifs
  e-mail folders, 1-5
  directory, 2-2
  file attributes, 3-23
  finding files, 4-2
ftp access, 2-21
how does it help you, 1-9
installing ifs utilities, 2-5
logging in using windows, 2-3
logging on using the web, 2-8
mail folder, 3-4
related documents, ii
security, 6-2
using default folders, 3-2
using e-mail, 2-26
web components, 2-9
web interface, 1-3
windows interface, 1-2
iFS Attributes tab (Windows), 3-25
iFS Find tool
buttons, 4-7
explanation of, 4-5
iFS Security tab, 6-14
and ACLs, 6-15
intended audience, i

K

keystroke commands, ii

L

language
assigning to a file (Web), 3-12
reasons for using (Web), 3-12
links
contrasted with shortcuts, 3-17
creating using the web, 3-22
deleting a file link, 3-22
display characteristics, 3-17, 3-22
document parents, 3-18
how they work, 3-17
overview, 3-17
purpose of, 3-17
using, 3-17
working with using the web, 3-22
List Parents function, 3-19
lock icon
explanation of, 5-19
removing, 5-19

locked state
definitions of, 3-26
locking
and change history, 5-17
files and folders, 5-17
iFS Lock feature, 5-18
lock states defined, 3-26
overview, 5-17
uses for, 5-2, 5-17
locking feature, 5-2

N

Name & Location tab (Windows), 4-8
nonversioned files
working with, 5-5

P

password
changing, Web, 6-11
changing, Windows, 6-10
passwords
changing using the web, 6-11
windows, 6-10
permissions
and ACEs, 6-2
granting, 6-6
introduction, 6-5
revoking, 6-6, 6-18
permissions, definition, 6-2
Properties window, 6-14

Q

Quick Tour, 2-9

R

result list (Windows), 4-14

S

search
advanced criteria, 4-11
bases for, 4-2
executing using windows, 4-14
specifying content criteria, 4-13
using the web, 4-15
search result
and user’s permissions, 4-2
search terms
saving, 4-2
searches
Add All Options (Web), 4-15
adding and removing criteria (Web), 4-18
advanced (Web), 4-18
Advanced iFS Find (Web), 4-15
Advanced tab, 4-9
by date criteria, 4-9
by file name and location, 4-8
custom (Web), 4-22
executing (Web), 4-20
for custom attributes (Web), 4-18
of document sections (Web), 4-22
on attributes, 4-2, 4-3
on attributes, custom, 4-3
on content, 4-2, 4-3
on content (Web), 4-16
on file description, 4-8
on phrases, 4-4
result list, 4-14
theme, 4-2
Windows
case sensitivity, 4-7
retrieving all versions, 4-7
with Boolean operators, 4-23
section searches, 4-23
section searches (Web), 4-22
security, 6-2, 6-4
changing passwords, 6-10
Select check box, 2-14
structure of this guide, i
U
users
deleting from an ACL, 6-18
utilities
installing, 2-5
V
versioned files
multiple versions (Web), 5-13
working with, 5-6
versioning, 5-2
access a previous version using the web, 5-11
accessing a previous version of a file, 5-9
and check out, 5-2
and check-in, 2-13, 5-2
and the History command (Web), 5-3
and the iFS Versions tab (Windows), 5-3
copying versioned files, 5-4
dceiver, 5-4
how it works, 5-3
making a file versioned using the web, 5-10
overview, 5-2
process, 5-4
removing, 5-9
searching for multiple versions (Windows), 4-7
using windows, 5-7
value of, 5-2
viewing history using windows, 5-8
versioning feature
value of, 5-2
W
Web
Advanced iFS Find
Add All Options, 4-15
Advanced iFS Find window, 4-15
content searches, 4-16
web, 1-3
accessing a previous version, 5-11
accessing ifs, 2-8
adding and removing search criteria, 4-18
advanced search, 4-18
advantages for creating ACLs, 6-21
banner, 2-10
basic search, 4-16
changing a password, 6-11
check in, 5-16
check out, 5-16, 5-17
closing a folder, 3-8
components, 2-9
copying files, 3-15
copying folders, 3-8
creating a custom ACL, 6-19
creating a link, 3-22
creating and using ACLs, 6-19
creating new folders, 3-8
deleting a file link, 3-22
deleting a folder, 3-9
deleting files, 3-16
directory tree, 2-11
displaying document parents, 3-22
executing the find command, 4-20
file list, 2-14
finding files, 4-15
locking files, 5-19
making a file versioned, 5-10
moving files, 3-16
moving folders, 3-9
opening a file, 3-9
opening a folder, 3-7
renaming a folder, 3-8
renaming files, 3-16
search criteria, 4-21
setting an expiration date, 3-30
toolbar, 2-12
uploading a file using browse, 3-10
uploading a file using drag and drop, 3-13
uploading files, 3-10
working with files, 3-9
working with folders, 3-7
working with links and parents, 3-22
web folders, 1-2
and content management, 2-21
and Oracle iFS Utilities, 2-21
file size, 2-20
installation of, 2-18
WebDAV protocol, 1-2
Windows
Advanced tab, 4-9
date searches, 4-9
Name & Location tab, 4-8
search results, 4-14
windows, 1-2
accessing a previous version of a file, 5-9
accessing ifs, 2-3
changing attribute values, 3-26
changing passwords, 6-10
content criteria for search, 4-13
creating and using ACLs, 6-16
executing the search, 4-14
finding files, 4-5
locking files, 5-18
logging into ifs, 2-3
mapping a network drive to ifs, 2-3
removing a version, 5-9
setting expiration date, 3-27
specifying advanced search criteria, 4-11
using check in, 5-15
using check out, 5-15
using the file attributes tab, 3-25
versioning a file, 5-7
view parent folders of a file, 3-19
viewing a file’s version history, 5-8
viewing file attributes, 3-23
working with files, 3-7
working with folders, 3-5
working with links and parents, 3-18
WITHIN operator
using, 4-22
XML files
and DTD validation, 3-5
storing, 3-5